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preface

USING THIS GUIDE

This Maintenance and Service Guide is a troubleshooting guide that can be used for
reference when servicing the Compaq Armada 3500 Family of Personal Computers.

Compaq Computer Corporation reserves the right to make changes to this product without
notice.

Additional information is available in the Compaq Armada 3500 Family of Personal
Computers Illustrated Parts Map.

Symbols

The following words and symbols mark special messages throughout this guide:

! WARNING:   Text set off in this manner indicates that failure to follow
directions in the warning could result in bodily harm or loss of life.

CAUTION:  Text set off in this manner indicates that failure to follow
directions in the caution could result in damage to equipment or loss of
information.

IMPORTANT:   Text set off in this manner presents clarifying information or specific
instructions.

NOTE:  Text set off in this manner presents commentary, provides helpful hints,
reminders, or additional information, or interesting points of information.
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Technician Notes

! WARNING:   Only authorized technicians trained by Compaq should
attempt to repair this equipment. All troubleshooting and repair
procedures are detailed to allow only subassembly/module level repair.
Because of the complexity of the individual boards and subassemblies, no
one should attempt to make repairs at the component level or to make
modifications to any printed wiring board. Improper repairs can create a
safety hazard. Any indication of component replacement or printed wiring
board modifications may void any warranty or exchange allowances.

! WARNING:   The computer is designed to be electrically grounded. To
ensure proper operation, plug the AC power cord into a properly grounded
electrical outlet only.

CAUTION:   To properly ventilate your system, you must provide at least 3
inches (7.62 cm) of clearance on the left and right sides of the computer.

Serial Number

When requesting information or ordering spare parts, provide the computer serial number.
The serial number is on the bottom of the computer.

Laser Safety
All Compaq systems equipped with CD-ROM drives comply with appropriate safety
standards, including IEC 825.  With specific regard to the laser, the equipment complies
with laser product performance standards set by government agencies as a Class 1 laser
product. It does not emit hazardous light; the beam is totally enclosed during all modes of
customer operation and maintenance.

CDRH Regulations
The Center for Devices and Radiological Health (CDRH) of the U.S. Food and Drug
Administration implemented regulations for laser products on August 2, 1976. These
regulations apply to laser products manufactured from August 1, 1976. Compliance is
mandatory for products marketed in the United States.

! WARNING:   Use of controls or adjustments or performance of procedures
other than those specified herein or in the CD ROM installation guide may
result in hazardous radiation exposure.
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This system is classified as a CLASS 1 LASER PRODUCT. This label is located on
the outside of the system being serviced. A similar label also appears on the internal
CD-ROM installed in the system.

LASER INFO

Laser Type: Semiconductor  GaAIAs
Wave Length: 780 +/- 35 nm
Divergence Angle: 53.5 Degree +/- 1.5 Degree
Output Power: Less than 0.2mW or 10,869 W•m-2sr-1

Polarization: Circular
Numerical Aperture: 0.45 +/- 0.04

Only an authorized technician, service provider, dealer, or reseller should attempt to repair
this equipment. All troubleshooting and repair procedures are detailed to allow only
subassembly/module level repair. Because of the complexity of the individual boards and
subassemblies, no one should attempt to make repairs at the component level or to make
modifications to any printed wiring board. Improper repairs can create a safety hazard as
well as void the warranty.

Battery Notice

! WARNING:  This computer contains an internal lithium battery-
powered real-time clock circuit. There is a risk of explosion and injury
if the battery is incorrectly replaced or improperly handled. Do not
attempt to  recharge, disassemble, immerse in water, or dispose of
the battery in fire. Replacement should be done using the Compaq
spare part for this computer.

! WARNING:  The computer also contains a lithium-ion battery pack.
There is a risk of fire and chemical burn if the battery pack is handled
improperly. Do not disassemble, crush, puncture, short external
contacts, dispose of in fire or water, or expose this battery to
temperatures higher than 60 degrees C.

In North America, dispose of nickel metal hydride or lithium-ion batteries by taking
advantage of the Compaq battery recycling program. You will be provided with a postage-
paid battery pack mailer preaddressed to a reclamation facility where the metals are
recycled.

In Europe, do not dispose of batteries and
accumulators with general household waste.
Dispose of or recycle them by using the public
collection system or returning them to Compaq.
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Locating Additional Information

The following documentation is available to support the computer:

■ Compaq Armada 3500 Family of Personal Computers documentation set

■ Microsoft operating system guide

■ Compaq service advisories and bulletins

■ Compaq QuickFind

■ Compaq Service Quick Reference Guide

■ Technical Reference Guide

■ Illustrated Parts Map

■ Compaq Internet site at http://www.Compaq.com
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chapter
 1

PRODUCT DESCRIPTION

1.1  Computer Features and Models

The Armada 3500 Family of Personal Computers is a line of thin and lightweight
notebook computers with superior flexibility and the latest performance features. It is
designed for highly mobile professionals who spend a majority of their time traveling.

Figure 1-1.  Armada 3500 Personal Computer with Mobile 3500
Expansion Unit
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This full-function, Mobile Pentium II-based family of notebook computers allows full
desktop functionality. It also provides connectivity through the use of an optional
Mobile 3500 Expansion Unit (M35EU) and a Convenience Base.

1.1.1 Features
The computer models have the following standard features:

■ 266- or 300-MHz Mobile Pentium II processors

■ 32- or 64-MB of synchronous dynamic random access memory (SDRAM),
expandable to a maximum of 160 MB1

■ 4.0-, or 6.0-GB, 2.5-inch internal hard drive mounted in carrier

■ LCD displays:

❏ 12.1 inch SVGA CTFT display

❏ 13.3-inch XGA CTFT display

■ Supports Lithium Ion (Li-ion) battery pack

■ Internal speaker

■ Internal microphone

■ External 1.44-MB diskette drive

■ Full-size 101 key compatible keyboard including 12 function keys, 8 cursor control
keys, inverted-T cursor control keys, and embedded numeric keypad

■ Four user-programmable keys

■ Multifunctional EasyPoint IV pointing device

■ Operates from a battery pack in the battery bay, an external AC power supply that is
compatible with domestic or international power sources, or from an AC power
supply integrated in the Mobile 3500 Expansion Unit

■ Power management and security features

■ Infrared interface for wireless communication with other IrDA-compliant devices at
data rates up to 4 mb/sec2 (available on selected models)

■ Universal Serial Bus (USB)

■ Two standard device slots that will accommodate two Type II or one Type III PC
Card, PCMCIA card or CardBus card. The Compaq telephony modem is supported
in the top slot and Zoomed-Video in the bottom slot

■ When connected to the Mobile 3500 Expansion Unit, a 176-pin expansion connector
provides the interface to the convenience base options (Mobile 3500 Expansion Unit
required for use with convenience base.)

■ Rear-panel ports provide connections for parallel, serial, external monitor,
microphone/Line-In jack, speaker/headphone (Line-Out jack), and keyboard/mouse

                                                       
1 Will support up to a maximum of 192-MB when 128-MB module becomes available.
2 Windows 95 supports up to 115-kb/sec. Driver for 4 mb/sec available from www.microsoft.com.
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1.1.2 Models
Compaq Armada 3500 computers are configurable, and may contain any or all of the
features listed. All models have 32- or 64-MB of standard memory, and may be
upgraded to a maximum of 192-MB.

1.1.3 Software Fulfillment
Replacement software may be ordered directly from Compaq Computer Corporation.
Both the model and the serial number of the computer are needed to identify the
specific software available.

1.2  Computer Options

The computer supports the following options:

■ Memory expansion boards

■ Li-ion battery pack

■ External battery charger with AC adapter

■ Hard drive upgrade

■ Mobile 3500 Expansion Unit (M35EU)

❏ CD-ROM or DVD-ROM drive for optical disc bay

❏ 6.4-GB hard drive for MultiBay (Not compatible with system hard drive.)

❏ 120-MB LS-120 super drive for MultiBay

❏ 100-MB Zip drive for MultiBay

❏ Hard drive adapter for MultiBay

1.2.1 Convenience Base II
Armada 3500 models support the following convenience base models when attached to
the M35EU:

■ Convenience Base II pass through

■ Convenience Base II with Ethernet

In addition, the computer is compatible with the convenience bases from the Armada
1500 Family of Personal Computers.

1.2.2 System Memory Options
The computer supports optional 16-, 32-, 64-, and 128-MB memory boards. The
memory boards are 66-MHz SDRAM without parity. System memory can be expanded
to up to 192-MB, depending on the model.
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1.2.3 External Battery Charger
The external battery charger has the following features:

■ Accepts Armada 3500 battery pack

■ Charges two sizes of battery packs

❏ 6-cell battery pack in 1.5 hours

❏ 9-cell battery pack in 2.0 hours

Note:  The battery calibration process should be used to discharge the batteries.

1.2.4 External Keyboards and Pointing Devices
Supports Compaq or Compaq compatible PS/2 keyboards and pointing devices.

1.2.5 External Monitors
■ Supports all VGA Monitors at resolutions up to 1280 × 1024

■ Supports DDC1 and DDC2b compliant Energy Star monitors
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1.3  External Computer Components

The external computer components are illustrated and described in this section.

1.3.1 Left Side Components
The left side external components are shown in Figure 1-2 and are described in
Table 1-1.

Figure 1-2.  Left Side Components

Table 1-1
Left Side Components

Ite
m

Component Function

1 Cable Lock Secures computer to fixed object
2 Air exhaust vent Provides warm air exit
3 USB port Connects USB devices
4 External diskette port Connects diskette drive
5 Volume up Increases volume
6 Volume down Decreases volume
7 Air inlet vent Provides cool air inlet
8 Battery Powers computer
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1.3.2 Front Components
The front external components are shown in Figure 1-3 and are described in Table 1-2.

Figure 1-3.  Front Components

Table 1-2
Front Components

Ite
m

Component Function

1 Display LCD graphic display
2 Lid latches Secures lid for transport
3 Lid switch Blanks display when lid is closed
4 M35EU slots Secures computer to Mobile 3500 Expansion Unit
5 Hard disk activity LED Indicates hard disk activity
6 Power LED Indicates that the computer is on
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1.3.3 Top Components
The top external components are shown in Figure 1-4 and are described in Table 1-3.

Figure 1-4.  Top Components

Table 1-3
Top Components

Ite
m

Component Function

1 Programmable function
buttons

User-programmable keys

2 Suspend button Initiates suspend
3 Power switch Turns power on and off
4 Microphone Input for audio recording
5 Display switch Turns display off when lid is closed
6 Keyboard release latches Releases keyboard from system unit
7 EasyPoint IV Pointing device
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8 Click buttons Pointing device click buttons
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1.3.4 Right Side Components
The right side external components are shown in Figure 1-5 and are described in
Table 1-4.

Figure 1-5.  Right Side Components

Table 1-4
Right Side Components

Ite
m

Component Function

1 Speaker Produces monaural audio when not docked to MEU
2 PC Card slots Accepts 16- and 32-bit PC Cards
3 DC Connector DC input from external AC adapter
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1.3.5 Rear Components
The rear components are shown Figure 1-6 and are described in Table 1-5.

Figure 1-6.  Rear Components

Table 1-5
Rear Components

Ite
m

Component Function

1 External keyboard port Connects external keyboard or PS-2 mouse
(Supports standard Y connector)

2 Infrared port Provides wireless communications (on selected
models)

3 Parallel connector Connects parallel devices such as a printer
4 Serial connector Connects serial devices such as a mouse
5 Docking connector Provides connection to optional convenience base
6 External monitor

connector
Connects external monitor

7 Mic in connector Connects external microphone
8 Headphone connector Connects stereo speakers, headphones or headset
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1.3.6 Computer Bottom Components
The bottom external components are shown in Figure 1-7 and are described in
Table 1-6.

Illustration
Not Available

Figure 1-7.  Bottom Components

Table 1-6
Bottom Components

Ite
m

Component Function

1
2
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1.3.7 M35EU Bottom Components
The bottom external components are shown in Figure 1-7 and are described in
Table 1-6.

Figure 1-8.  Bottom Components

Table 1-7
Bottom Components With M35EU

Ite
m

Component Function

1 Subwoofer Enhances sound reproduction
2 Locking tabs Secures computer to Convenience Base II
3 Docking guide Aligns computer to Convenience Base II when

docking
4 Speakers Produces high-quality sound
5 Optical bay retainer

cover
Provides access to optical bay connector and
retainer
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1.3.8 Status Panel Lights
The status panel lights are shown in Figure 1-9 and described in
Table 1-8.

Figure 1-9.  Status Panel Lights

Table 1-8
Status Panel

Ite
m

Component Function

1 Hard drive activity light Indicates hard drive or CD-ROM access
2 Diskette drive activity

light
Indicates diskette drive activity

3 Number lock indicator Indicates that numbers lock is on
4 Caps lock indicator Indicates that caps lock is on
5 Scroll lock indicator Indicates that scroll lock is on
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1.4  Design Overview

This section presents a design overview of the computer. The overview is limited to
field replaceable parts. All replacement parts are listed in Chapter 3.

1.4.1 System Unit
The computer is a traditional clamshell design with a display assembly attached to a
system unit. The computer opens to reveal a backlit LCD display and a full-function
keyboard. The display is designed for a continuously adjustable tilt angle. Multimedia
capability and connectivity are enhanced through an optional Mobile 3500 Expansion
Unit.

1.4.2 Internal Boards
The system electronics are integrated on three printed circuit assemblies: the system
board, the DC-DC converter board, and LED/switch board.

■ The system board integrates the processor, on-board memory, level 2 cache, local
bus video adapter, audio functions, and PCMCIA/CardBus adapter.

■ The DC-DC converter board creates the system voltages (3.3v and 5v) from the
battery or AC/DC input.

■ The LED/switch board integrates the status LEDs and the power and hibernation
switches.

1.4.3 Processor
An Intel 266- or 300-MHz Mobile Pentium II processor is located on the system board.

1.4.4 Memory
Base memory is 32- or 64-MB with 16-, 32-, 64-, or 128-MB of optional expansion
memory. Base memory is onboard memory built into the system board. Expansion
memory consists of one memory expansion board available as a user installable option.

1.4.5 Cache
Level 2 cache is integrated in the CPU module. It is not user upgradable.

1.4.6 PCMCIA/CardBus and Video Adapter
Controller
The PCMCIA/CardBus adapter is based on the Texas Instrument PCI1220 PC to
CardBus controller unit. The local bus video adapter is the Chips and Technologies
69000 controller. This controller offers improved video performance due to the
on-board 2-MB video memory.
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1.4.7 Video system
The standard video subsystem consists of:

■ One of the following LCD displays:

❏ 12.1-in SVGA CTFT display

❏ 13.3-in XGA CTFT display

■ A 2-Megabyte frame buffer integral with the video controller integrated circuit

■ An inverter to supply AC power to the LCD back-light system

■ A standard external VGA connector for use with CRTs and other VGA compatible
displays

■ A 40-KB Video ROM
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chapter
 2

TROUBLESHOOTING

Follow these basic steps when beginning the troubleshooting process:

1. Complete the preliminary steps listed in Section 2.1.
2. Run the Power-On Self-Test (POST) as described in Section 2.3.
3. Run Computer Setup as described in Section 2.5.
4. Run the Computer Checkup (TEST) as described in Section 2.6.
5. If you are unable to run POST or Computer Checkup or if the problem persists

after running POST and Computer Checkup, perform the recommended actions
described in the diagnostic tables in Section 2.5.

Follow these guidelines when troubleshooting:

■ Complete the recommended actions in the order in which they are given.

■ Repeat POST and Computer Checkup after each recommended action until the
problem is resolved and the error message does not return.

■ When the problem is resolved, stop performing the troubleshooting steps and do not
complete the remaining recommended actions.

■ Refer to Chapter 5 for removal and replacement procedures that are recommended.

■ If the problem is intermittent, check the computer several times to verify that the
problem is solved.

The following table describes the troubleshooting actions:

If You Want To: Then Run:

Check for POST error messages POST
Check that computer components are
recognized and running properly

Computer Checkup (TEST) under
Compaq Utilities

View information about the computer and
installed or connected devices

View System Information (INSPECT)
under Compaq Utilities

Perform any of the following:
■ Check the system configuration
■ Set the system power management

parameters
■ Return the system to its original configuration
■ Check system configuration of installed

devices

Computer Setup
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2.1  Preliminary Steps
IMPORTANT:   Use AC power when running POST, Computer Setup, or Computer
Checkup. A low battery condition could initiate Hibernation and interrupt the test.

Before running POST and Computer Checkup, complete the following steps:

1. Obtain established passwords. If you must clear the passwords, go to Section 2.2.
2. Ensure that the battery pack is installed in the computer and the power cord is

connected to the computer and plugged into an AC power source.
3. Turn on the computer.
4. If a power-on password has been established, type the password and press Enter.
5. Run Computer Setup (Section 2.5). If a Setup password has been established, type

the password and press Enter.
6. Turn off the computer and all external devices.
7. Disconnect external devices that you do not want to test. If you want to use the

printer to log error messages, leave it connected to the computer.

NOTE:   If a problem only occurs when an external device is connected to the
computer, the problem could be with the external device or its cable. Isolate the
problem by running POST with and without the external device connected.

9. Use Compaq Utilities and loopback plugs in the serial and parallel connectors if you
plan to test these ports.

Follow these steps to run Compaq Utilities:

a. If you are running Compaq Utilities from the hard drive, turn on or restart the
computer. Press F10 when the cursor appears in the upper right corner of the
screen. If you do not press F10 in time, restart the computer and try again.

If you are running Compaq Utilities from diskette, insert the Compaq Utilities
diskette in drive A. Turn on or restart the computer.

b. Press Enter  to accept OK.

c. Select Computer Checkup (TEST).

d. Select Prompted Diagnostics.

e. After “Identifying System Hardware” completes, select Interactive Testing and
follow the instructions on the screen.
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2.2  Clearing Passwords
The power-on password prevents use of the computer until the password is entered. The setup password prevents
unauthorized changes to Computer Setup. To clear the passwords, you must remove all power from the system board.
If you do not know the passwords, use the following procedure to clear the password:

1. Remove the battery pack from the battery bay.
2. Disconnect the AC power.
3. Remove the real-time clock battery (Refer to Chapter 5, “Removing the Lithium

Real Time Clock Battery.”)
4. Remove the standby battery (Refer to Chapter 5, “Removing the Nickel Cadmium

Standby Battery.”)
5. Wait five minutes.
6. Reconnect the AC power.
7. Restart the computer. During Power-On Self Test (POST), a “162 System Options

not set” message appears.
8. Turn off the computer, then disconnect AC power again.
9. Replace the real-time clock battery.

10. Replace the standby battery.

11. Install the battery pack.

12. Proceed with the troubleshooting procedures.

2.3  Power-On Self-Test (POST)
The Power-On Self-Test (POST) is a series of tests that run every time the computer is
turned on. POST verifies that the system is configured and functioning properly.

To run POST, complete the following steps:

1. Complete the preliminary steps (Section 2.1).
2. Turn on the computer.

If POST does not detect any errors, the computer beeps once or twice to indicate that
POST has run successfully. The computer boots from the hard drive or from a bootable
diskette if one is installed in the diskette drive.
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2.4  POST Error Messages
If the system is not functioning well enough to run POST, or if the display is not
functioning well enough to show POST error messages, refer to the Troubleshooting
tables in Section 2.6.

If POST detects an error, one of the following events occurs:

■ A message with the prefix “WARNING” appears informing you where the error
occurred. The system pauses until you press F1 to continue.

■ A message with the prefix “FATAL” appears informing you where the error
occurred. After the message, the system emits a series of beeps and stops.

■ The system emits a series of beeps and stops.

Warning messages indicate that a potential problem, such as a system configuration
error, exists. When F1 is pressed, the system should resume. You should be able to
correct problems that produce WARNING messages.

IMPORTANT:   When a WARNING message includes the prompt to “RUN SCU,”
press F10 to run Computer Setup. (Computer Setup replaces the SCU utility.)

If you receive one of the error messages listed below, follow the recommended action.

Table 2-1
Warning Messages

Message Description Recommended Action
CMOS checksum invalid, run
SCU

CMOS RAM information
has been corrupted.

Run Computer Setup to
reinitialize CMOS-RAM.

CMOS failure, run SCU CMOS RAM has lost
power.

Run Computer Setup to
reinitialize CMOS-RAM.

Diskette controller error The diskette drive
controller failed to
respond to the recalibrate
command.

If there is no diskette drive in
the system, run Computer
Setup to properly configure the
CMOS-RAM to show no
diskette drive present. If the
problem persists, or if a
diskette drive is present,
complete these steps until the
problems is solved:
1. Check diskette drive
connections.
2. Replace diskette drive.
3. Replace system board.

Diskette track 0 failed The diskette drive cannot
read track 0 of the
diskette in the drive.

Try another diskette. If the
problem persists, you may
need to replace the diskette
drive.

Hard disk controller error The hard drive controller
failed to respond to the
reset command.

Check the drive parameters.
Turn off the system and check
all related connections.

Keyboard controller failure The keyboard failed the
self-test command.

Replace the system board.
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Keyboard failure The keyboard failed to
respond to the RESET ID
command.

Replace the keyboard. If the
problem persists, replace the
system board.

Continued 
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Table 2-1 Warning M essages  Continued

If You Want To: Then Run:
No interrupts from Timer 0 The periodic timer

interrupt is not occurring.
Replace the system board.

ROM at xxxx (LENGTH yyyy)
with nonzero checksum (zz)

An illegal adapter ROM
was located at the
specified address.

Check the external adapter
(such as a video card) to
determine if it is causing the
conflict.

Time/Date corrupt - run SCU The time and date stored
in the real time clock
have been corrupted,
possibly by a power loss.

1. Run Computer Setup.
2. If problem persists, replace

RTC battery.
3. If problems persists, replace

system board.
Hard disk xx failure (or error) A failure or an error

occurred when trying to
access the hard drive.

1. Run Scan disk.
2. Check disk in DOS and

Windows 95. If problem
persists, refer to Table 2-
10.

Unsupported memory module An EDO memory module
was installed in the
memory expansion slot.

Remove the EDO memory
module and replace with
SDRAM memory module.

Fatal errors emit a beep and may display a FATAL message. Fatal errors indicate
severe problems, such as a hardware failure. Fatal errors do not allow the system to
resume. Some of the Fatal error beep codes are listed at the end of this section.

Table 2-2
Fatal Error Messages

Message Description Beep Code
CMOS RAM test failed A walking bit test of CMOS RAM

location 0E (Hex) - 3F (Hex) failed.
3

DMA controller faulty A sequential read/write of the transfer
count and transfer address registers
within the primary and secondary
DMA controllers failed.

4

Faulty DMA page registers A walking bit read/write of the 16
DMA controller page registers starting
at location 80 Hex failed.

0

Faulty refresh circuits A continuous read/write test of port
61h found that bit 4 (Refresh Detect)
failed to toggle within an allotted
amount of time.

1

Interrupt controller failed A sequential read/write of various
Interrupt Controller registers failed.

5

ROM checksum incorrect A checksum of the ROM BIOS does
not match the byte value at
F000:FFFF.

2

RAM error at location xxxx RAM error occurred during memory
test.

None
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Table 2-3
Fatal Error Beep Codes

Beep
Code

Beep Sequence Description Recommended Action

0 S-S-S-P-S-S-L-P The DMA page registers
are faulty.

Replace system board.

1 S-S-S-P-S-L-S-P The refresh circuitry is
faulty.

2 S-S-S-P-S-L-L-P The ROM checksum is
incorrect.

3 S-S-S-P-L-S-S-P The CMOS RAM test failed.
4 S-S-S-P-L-S-L-P The DMA controller is

faulty.
5 S-S-S-P-L-L-S-P The interrupt controller

failed.
6 S-S-S-P-L-L-L-P The keyboard controller

failed.
7 S-S-L-P-S-S-S-P Graphics adapter is faulty.
8 S-S-L-P-S-S-L-P Internal RAM is faulty. Replace memory board

or system board if
memory on system
board is faulty.

S = Short, L = Long, P = Pause
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2.5  Compaq Utilities
Compaq Utilities contain several functions that

■ Determine if various computer devices are recognized by the system and are
operating properly.

■ Provide information about the system once it is configured.

Compaq Utilities include the following programs:

■ Computer Setup

■ Computer Checkup (TEST)

■ View System Information (INSPECT)

To access Compaq Utilities:

1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the
computer.

2. Press F10 when the blinking cursor appears in the upper-right corner of the display.
3. Select a menu option.

2.5.1 Computer Setup
Computer Setup contains utilities that give you an overall picture of the computer
hardware configuration and aid in troubleshooting. These utilities also allow you to set
custom features such as security options, power conservation levels, and startup
preferences.

If you are running Windows 95, the computer automatically recognizes and configures
the system for new devices. If you have a configuration problem or want to view or
reset configuration settings, you can use Computer Setup.

NOTE:  In Windows 95, you should use Computer Setup only to adjust system
features such as the power-on password or battery conservation level. Windows 95
may override other configuration changes.

In Windows NT, the computer does not automatically recognize new devices added to
the system. All devices ordered with your system have been configured for you. Use
Computer Setup to view settings for a new device you have added or to reset
configuration settings for preinstalled devices.

Computer Setup provides two methods of viewing the computer configuration:  by type
(factory setting) or connection.
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Categories by type:

■ System Features—security, power, boot management

■ Communication—port, modem, and other communication devices

■ Storage—storage-related devices such as hard drive, CD-ROM drive, diskette drive

■ Input Devices—keyboard, mouse, and other input devices

■ Network—network adapter or other network-related devices

■ Audio—sound properties and audio device settings

■ Video—display timeouts and video device resources

■ Other—miscellaneous devices

Categories by connection:

■ System Features—security, power, boot management

■ System Devices—keyboard, mouse, parallel and serial ports

■ ISA—ISA bus and connected devices

■ PCI—PCI bus and connected devices

■ PC Card—PC Card devices

2.5.1.1 Running Computer Setup
1. Turn on or restart the computer by clicking Start ⇒ Shut Down ⇒ Restart the

computer.
2. Press F10 when the blinking cursor appears in the upper-right corner of the screen.
 NOTE:  If you a setup password is enabled, it must be used to access Computer

Setup.
3. Click a language and press Enter.
4. Click Computer Setup and press Enter .
5. When you are finished, click Exit.
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2.5.1.2 Exiting Computer Setup
1. Click Exit.
2. Select one of the following Exit options:

■ Save—Saves the new settings and exits Computer Setup.

NOTE:  Some settings may not take effect until the computer is restarted.

■ Ignore—Exits Computer Setup and restores previous settings.

■ Cancel—Returns to Computer Setup.

2.5.2 Computer Checkup (TEST)
Computer Checkup (TEST) determines whether the various computer components and
devices are recognized by the computer and are functioning properly. You can display,
print, or save the information that Computer Checkup generates.

NOTE:  Compaq Utilities are intended for testing only Compaq-supplied components.
Testing of non-Compaq components may be inconclusive.

2.5.2.1 Running Computer Checkup (TEST)
1. Plug the computer into an external power source. A low battery condition can

interrupt the program.
2. Connect a printer if you want to print a log of error messages.
3. Turn on the external devices that you want to test.
4. Turn on or restart the computer.
5. Access Compaq Utilities by pressing F10 when the blinking cursor appears in the

upper-right corner of the display.
6. Click Computer Checkup ⇒ View the Device List.

■ If the list of installed devices is correct, click OK.
■ If the list is incorrect, ensure that any new devices are installed properly.

7. Select one of the following from the Test Option menu:

■ Quick Check Diagnostics

■ Automatic Diagnostics

■ Prompted Diagnostics

8. Follow the instructions on the screen as the devices are tested.
9. Click Exit Diagnostics ⇒ Exit from this utility.
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2.5.2.2 Computer Checkup (TEST) Error Codes
Computer Checkup (TEST) error codes occur if the system recognizes a problem while
running Computer Checkup. These error codes help identify possible defective
assemblies. Tables 2-4 through 2-14 list Computer Checkup error codes, a description
of the error condition, and the recommended action for resolving the condition. For
removal and replacement procedures, refer to Chapter 5.

IMPORTANT:  Run Computer Checkup each time you complete a recommended
action step. If the problem is resolved when POST and Computer Checkup are rerun
(i.e., with no error codes), do not perform the remaining recommended action steps.

NOTE:  The error codes in the following tables are listed in an “AYE-XX” format,
where:

A or AA = Number that represents the faulty assembly

 YY = Test or action that failed

 XX = Specific problem

Table 2-4
Processor Test Error Codes

Error
Code

Description Recommended Action

101-xx CPU test failed. Replace the processor board and retest.
103-xx DMA page registers test failed. Replace the system board and retest.
104-xx Interrupt controller master test

failed.
105-xx Port 61 error.
106-xx Keyboard controller self-test failed.
107-xx CMOS RAM test failed.
108-xx CMOS interrupt test failed.

109-xx CMOS clock test failed.

110-xx Programmable timer load data test
failed.

113-xx Protected mode test failed.
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Table 2-5
Memory Test Error Codes

Error
Code

Description Recommended Action

200-xx Memory machine ID test failed. The following steps apply to error codes
200-xx and 202-xx:

202-xx Memory system CMOS checksum
failed.

1. Flush the system CMOS and retest.
See note.
2. Replace the system board and retest.

203-xx Write/Read test failed. The following applies to error codes
203-xx through 215-xx:

204-xx Address test failed. Remove and replace the SODIMM
memory board or system board (if the
memory on the system board is faulty)
and retest.

211-xx Random pattern test failed.
214-xx Noise test failed.

215-xx Random address test failed.

Table 2-6
Keyboard Test Error Codes

Error
Code

Description Recommended Action

300-xx Failed ID Test. 1. Reseat the keyboard connector.

301-xx Failed Self test/Interface Test. 2. Replace the keyboard and retest.

302-xx Failed Individual Key Test. 3. Replace the system board and
retest.

304-xx Failed Keyboard Repeat Test.

Table 2-7
Parallel Printer Test Error Codes

Error
Code

Description Recommended Action

401-xx Printer failed or not connected. 1. Connect the printer.

402-xx Failed Port Test. 2. Check power to the printer.

403-xx Printer pattern test failed. 3. Install bi-directional printer cable and
retest.

4. Install the loopback connector and
retest.

5. Check port and IRQ configuration.
6. Replace the system board and

retest.
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Note:  Fn + F11 clears the ESCD configuration information. If the Fn + F11 sequence
is pressed very early after powering the machine on (after you see the keyboard LEDs
blink, but before the video is initialized), CMOS memory will be invalidated. The
ESCD is cleared, the machine is reset and boots with the “162 - System Options Not
Set” message. This is a way to clear out configuration information, such as Windows
95’s knowledge about a docking station. It may help clear up problems if the
configuration information had been corrupted. Timing of this keystroke sequence is
critical, as there is a very narrow window during which the keys will be recognized.
These keys are not documented to users.
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Table 2-8
Diskette Drive Error Codes

Error
Code

Description Recommended Action

600-xx Diskette ID drive types test
failed.

The following steps apply to error codes
600-xx through 698-xx:

601-xx Diskette format failed. 1. Replace the diskette.
602-xx Diskette read test failed. 2. Replace the diskette drive and retest.
603-xx Diskette write, read, compare test

failed.
3. Replace the system board and

retest.
604-xx Diskette random read test failed.

605-xx Diskette ID media test failed.
606-xx Diskette speed test failed.
609-xx Diskette reset controller test failed.
610-xx Diskette change line test failed.
697-xx Diskette type error.
698-xx Diskette drive speed not within

limits.
699-xx Diskette drive/media ID error. 1. Replace media.

2. Run Compaq Utilities.

Table 2-9
Serial Test Error Codes

Error
Code

Description Recommended Action

1101-xx Serial port test failed. 1. Check port configuration.
2. Replace the system board and

retest.

Table 2-10
Hard Drive Test Error Codes

Error
Code

Description Recommended Action

1701-xx Hard drive format test failed. 1. Run Compaq Utilities and verify drive
type.

1702-xx Hard drive read test failed. 2. Verify that all secondary drives have
secondary drive capability.

1703-xx Hard drive write/read/compare test
failed.

3. Replace the hard drive and retest.

1704-xx Hard drive random seek test failed. 4. Replace the system board and retest.
1705-xx Hard drive controller test failed.
1706-xx Hard drive ready test failed.
1707-xx Hard drive recalibration test failed.
1708-xx Hard drive format bad track test

failed.
1709-xx Hard drive reset controller test

failed.
1710-xx Hard drive park head test failed.
1715-xx Hard drive head select test failed.
1716-xx Hard drive conditional format test

failed.
1717-xx Hard drive ECC* test failed.
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1719-xx Hard drive power mode test failed.
1724-xx Network preparation test failed.
1736-xx Drive monitoring test failed.

* ECC = Error Correction Code
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Table 2-11
Video Test Error Codes

Error
Code

Description Recommended Action

501-xx Video controller test failed. The following actions apply to error
codes 501-xx through 516-xx:

502-xx Video memory test failed. 1. Disconnect external monitor and test
with internal LCD display.

503-xx Video attribute test failed. 2. Replace the display assembly and
retest.

504-xx Video character set test failed. 3. Replace the system board and retest.
505-xx Video 80 × 25 mode 9 × 14

character
cell test failed.

506-xx Video 80 × 25 mode 8 × 8
character
cell test failed.

507-xx Video 40 × 25 mode test failed.
511-xx Video screen memory page test

failed.
512-xx Video gray scale test failed.
514-xx Video white screen test failed.
516-xx Video noise pattern test failed.

2402-xx Video memory test failed. The following actions apply to error
codes 2402-xx through 2456-xx:

2403-xx Video attribute test failed. 1. Run Compaq Utilities.
2404-xx Video character set test failed. 2. Disconnect external monitor and test

with internal LCD display.
2405-xx Video 80 × 25 mode 9 × 14

character cell test failed.
3. Replace the display assembly and

retest.
4. Replace the system board and retest.

2406-xx Video 80 × 25 mode 8 × 8
character cell test failed.

2411-xx Video screen memory page test
failed.

2412-xx Video gray scale test failed.
2414-xx Video white screen test failed.
2416-xx Video noise pattern test failed.
2418-xx ECG/VGC memory test failed.
2419-xx ECG/VGC ROM checksum test

failed.
2421-xx ECG/VGC 640 × 200 graphics

mode test failed.
2422-xx ECG/VGC 640 × 350 16 color set

test failed.
2423-xx ECG/VGC 640 × 350 64 color set

test failed.
2424-xx ECG/VGC monochrome text mode

test failed.
2425-xx ECG/VGC monochrome graphics

mode test failed.
2431-xx 640 × 480 graphics test failed.
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2448-xx Advanced VGA Controller test
failed.

Continued
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Table 2-11 Video Test Error Codes Continued

Error
Code

Description Recommended Action

2451-xx 132-column Advanced VGA test
failed.

2456-xx Advanced VGA 256 Color test
failed.

2458-xx Advanced VGA Bit BLT test failed. The following action applies to error
codes 2458-xx to 2480-xx:

2468-xx Advanced VGA DAC test failed. Replace the system board and retest.
2477-xx Advanced VGA data path test

failed.
2478-xx Advanced VGA BitBLT test failed.
2480-xx Advanced VGA Linedraw test

failed.
Refer to Table 2-25 for information about other video errors.

Table 2-12
Audio Test Error Codes

Error
Code

Description Recommended Action

114-01 Speaker test failed. 1. Check system configuration.
2. Check speaker cable connection to

system board
3. Replace speaker.

3206-xx Audio System Internal Error. Replace the system board and retest.

Table 2-13
Pointing Device Interface Test Error Codes

Error
Code

Description Recommended Action

8601-xx Pointing device test failed. Replace the keyboard.
8602-xx Interface test failed.

Table 2-14
CD-ROM Test Error Codes

Error
Code

Description Recommended Action

3301-xx CD-ROM drive read test failed. 1. Replace the CD and retest.
2. Verify that drivers are loaded and

properly installed.
3305-xx CD-ROM drive seek test failed. 3. Replace the CD-ROM drive and retest.

4. Replace the system board and retest.
6600-xx ID test failed.

6605-xx Read test failed.

6608-xx Controller test failed.
6623-xx Random read test failed.
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2.5.3 Running View System Information
(INSPECT)

The View System Information (INSPECT) utility provides information about the
computer and installed or connected devices. You can display, print, or save the
information.

In order to access the INSPECT utility, follow the instructions below:

1. Connect a printer if you want to print the INSPECT information.
2. Turn on or restart the computer.
3. Access Compaq Utilities by pressing F10 when the cursor blinks in the upper-right

corner of the display.
4. If prompted, select a language.
5. Click View System Information (INSPECT).
6. Click the item you want to view. The list includes the following:

■  System ■  Audio
■  ROM ■  Operating system
■  Keyboard ■  System files
■  System ports ■  Windows files
■  System storage ■  Miscellaneous
■  Graphics
■  Memory

■  Network (applicable only if
computer is docked in the
Convenience Base II)

7. Follow the instructions on the screen to cycle through the screens, to return to the
list and choose another item, or to print the information.

8. Select Exit Inspect.

2.5.4 Running Compaq Diagnostics
Compaq Diagnostics provides computer component information when the operating
system is working.

If you are running Windows 95, access Compaq Diagnostics for Windows by
double-clicking My Computer ⇒ Control Panel ⇒ Compaq Diagnostics.

2.5.5 Boot Sequencing
1. Run Computer Setup.
2. Click the System Features icon ⇒ Boot Management box ⇒ MultiBoot tab.
3. Designate the hard drive boot (startup) sequence you want.
4. Click OK to accept the changes.
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2.5.6 Factory Default Settings

Initialization
Enable POST Memory Test Checked (enabled)
Keyboard numbers Lock Unchecked (Off)

1 Hard drive in the computer
2 Hard drive in the computer MultiBay

Boot display Auto
Language Language of country

Ports
Serial/infrared ports

Serial port 3F8, IRQ4
Infrared port 2F8, IRQ3

Parallel port 378, IRQ7
Ethernet port 300, IRQ9

Power
Low Battery Warning Beep Checked (enabled)
External Energy Saving Monitor
Connected

Unchecked (not connected)

Power Management
Enabled While operating power on battery
Conservation Level Medium
Level Definition

High Suspend Time:  5 minutes
Hibernation Timeout:  Immediate
Drive Timeout:  2 minutes
Screen Timeout:  2 minutes

Medium Suspend Time:  10 minutes
Hibernation Timeout:  1 hour
Drive Timeout:  6 minutes
Screen Timeout:  4 minutes

Custom Suspend Time:  disabled
Hibernation Timeout:  low battery
Drive Timeout:  always on
Screen Timeout:  always on

Security
Enable QuickLock/QuickBlank Unchecked (Disabled)
Enable Power-On Password Unchecked (Disabled)
Disable Serial/Infrared Ports Unchecked (Enabled)
Disable Parallel Port Unchecked (Enabled)
Disable PC Card Slots Unchecked (Enabled)
Setup Password Password blank
Power-On Password Password blank
Diskette Drives

Disable Diskette Drives Unchecked (Enabled)
Disable Diskette Boot Unchecked (Enabled)
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2.6  Troubleshooting Without
Diagnostics

This section provides information about how to identify and correct some common
hardware, memory, and software problems. It also explains several types of messages
that may be displayed on the screen.

Since symptoms can appear to be similar, carefully match the symptoms of the
computer malfunction against the problem description in the Troubleshooting tables to
avoid a misdiagnosis.

2.6.1 Before Replacing Parts
When troubleshooting a problem, check the following items for possible solutions
before replacing parts:

■ Verify that cables are connected properly to the suspected defective parts.

■ Verify that all required device drivers are installed.

■ Verify that all printer drivers have been installed.

2.6.1.1 Solving Audio Problems

Table 2-15
Solving Audio Problems

Problem Probable Cause Recommended Act ion(s)
Computer does not
beep after the Power-
On Self-Test (POST).

Speaker volume has
been turned down.

Adjust the volume with the volume
control buttons located at the top
right corner of the computer.

Computer does not
beep to indicate a low-
battery condition.

Low-battery warning
beeps have been turned
off.

Enable low-battery warning beeps in
Windows 95 Power Properties or in
Computer Setup power
management.

System beeps have
been turned down too
low.

Press Fn+F5, then press the right
arrow key to increase the volume of
the system beeps.

Audio playback is too
low or too loud.

The computer volume
control and/or the
software volume control
needs to be adjusted.

In Windows 95, adjust the computer
volume control buttons and adjust
the volume control in Multimedia
Properties.
NOTE: The volume control in
Multimedia Properties only affects
the “Wave” audio sources such as
system sounds and *.wav file
playback. To change other sources
such as MIDI, video sound, and
game effects, use the Volume
Control application in
accessories/Multimedia.
In Windows NT, adjust the
multimedia volume control under the
Accessories folder.
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Internal speakers
produce no sound.

Volume has been
muted.

Press the increase volume control
button to increase the volume.
Press Fn+F5, then press the right
arrow key to increase the volume of
the system beeps

Continued



Compaq Confidential - Need to Know Required

Troubleshooting    2-23

Table 2-15 Solving Audio Probl ems  Continued

Problem Probable Cause Recommended Act ion(s)
Internal speakers
produce no sound
(continued).

External speakers or
headphones are
connected to the
computer.

Use the external speakers or
headphones or use the Convenience
Base II speakers.

To use the internal speakers,
disconnect the external speakers or
headphones or undock the
computer.

Speaker wires are not
connected.

Make sure the speaker wires are
connected properly.

Speakers are bad. Replace the speakers.
Internal speaker does
not produce sound
when an external audio
source is connected to
the stereo
line-in jack.

Volume may be turned
off or set too low.

■ Adjust the volume control
located at the top right corner of
the computer.

■ Use the volume control and
mixing features available in
Control Panel ⇒ Multimedia.

■ Adjust the volume using the
speaker icon on the taskbar.

Line input may not be
connected properly.

Check line input connection.

Headphones or
speakers are connected
to the stereo
speaker/headphone
jack, which disables the
internal speakers.

Disconnect the headphones or
speakers to enable the internal
speakers.

External microphone
does
not work.

The wrong type of
microphone or
microphone plug is
being used.

Check to see if a monophonic
electret condenser microphone with
a 3.5-mm plug is being used.

The microphone may
not be connected
properly.

Ensure that the microphone plug is
properly connected to the mono
microphone jack.

Sound source is not
selected.

Ensure that microphone is selected
as the recording source in Control
Panel ⇒ Multimedia and that the
recording level is adjusted.

No sound from game
program.

Audio settings are not
set correctly.

Check the game program audio
settings.

Computer volume
control is turned down.

Adjust the volume with the volume
control buttons located at the top
right corner of
the computer.

Headphones are
connected.

Use or disconnect the headphones.

No sound from
headphones.

Volume or mixing
controls set incorrectly.

■ Adjust the volume with the
volume control buttons located
at the top right corner of the
computer.

■ Use the volume control and
mixing features available in
Control Panel ⇒ Multimedia.
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Sound source not
selected.

Verify that the sound source is
selected in Control Panel ⇒
Multimedia.

Volume or mixing
controls set incorrectly.

■ Adjust the volume with the
volume control buttons located
on the right side of the
computer.

■ Check the volume and mixer
controls in Control Panel ⇒
Multimedia.
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2.6.1.2 Solving Battery Problems
The following table lists some common battery problems and recommended actions to
take when they occur. The “Solving Power Problems” section in this chapter also may
be applicable.

Table 2-16
Solving Battery and Battery Gauge Problems

Problem Probable Cause Recommended Act ion(s)
The computer turns on
the first time it is used,
but the battery does not
charge.

The battery pack is in
ship mode.

Remove and reinsert the battery
pack.

Computer does not turn
on when battery pack is
inserted and power cord
is unplugged.

Battery is discharged. Ensure that the battery  pack is
properly installed.

Connect the computer to an external
power source and charge the battery
pack.

Replace the battery pack with a fully
charged battery pack.
Check battery status by pressing
Fn+F8.

Computer beeped five
times and battery light is
blinking.

Computer has entered a
low-battery condition.

Immediately save any open file(s).
Then do one of the following:

1. Connect the computer to an
external power source.

2. Turn the computer off and replace
the battery pack.

Computer battery light
blinks to indicate low
battery condition, but
computer does not
beep.

Low battery beeps were
turned off.

Volume is turned off or
turned down too low.

Run Computer Setup and turn on the
low battery warning beeps.

Press Fn+F5 to adjust the volume of
the system warning beeps.

Battery light does not
turn on to indicate
battery pack Is charging.

Battery pack is already
charged.

Battery pack was
exposed to temperature
extremes.

No action is necessary.

Allow time for the battery pack to
return to room temperature.

Battery pack is at the
end of its life.

Replace the battery pack.

Battery pack is warm to
the touch after charging.

Warming occurs during
charging.

No action is required.

Continued



Compaq Confidential - Need to Know Required

2-26    Troubleshooting

Table 2-16 Solving Batt ery and Battery Gauge Pr oblems   Continued

Problem Probable Cause Recommended Act ion(s)

Computer turned off and
information in memory
was lost when the
battery pack was
replaced.

Hibernation was
disabled, Suspend was
not initiated, or AC
power was not
connected before the
discharged battery pack
was removed.

To prevent loss of information next
time, initiate Suspend, enable
Hibernation, or connect AC power
before changing batteries..

You have to set the date
and time every time you
turn on the computer.

Real time clock (RTC)
battery is at the end of
its life.

Replace the RTC battery.

Battery pack charge
does not last as long as
expected.

Battery pack is being
exposed to high
temperatures or
extremely cold
temperatures.

Keep the battery pack within the
recommended operating
temperature range 50°F to 104°F
(10°C to 40°C) or recommended
storage range -4°F to 86°F (-20°C
to 30°C ). Recharge the battery
pack.

Battery pack has
partially self-discharged.

If the computer is disconnected
from the external power for more
than two weeks, remove the battery
pack to reduce the self-discharge
rate.

Power management is
disabled.

Press Fn+F7 and set the power
conservation level.

An external device or
PC Card is draining the
battery.

Turn off or disconnect external
devices when not using them.

Computer is beeping
and battery power light is
blinking.

Battery pack charge is
low.

Do one of the following:
■ Charge the battery pack.

■ Replace the battery pack.

■ Connect the computer to an
external power source.

■ Initiate Hibernation.

2.6.1.3 Solving CD-ROM Drive Problems

Table 2-17
Solving CD-ROM Drive Problems

Problem Probable Cause Recommended Act ion(s)
CD-ROM drive cannot
read a compact disc.

Compact disc is not
properly seated in the CD-
ROM drive.

Open the CD loading tray, lay the
compact
disc on it, then close the tray.

Compact disc is loaded
in the CD loading tray
upside down.

Open the CD loading tray, turn over
the compact disc (label facing up),
then close
the tray.

Compact disc has a
scratch
on its surface.

Insert a different compact disc.
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CD-ROM drive is not
recognized by the
computer.

CD-ROM drive is not
connected properly.

Turn off the computer, remove the
CD-ROM drive and reinsert it.
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2.6.1.4 Solving Diskette and Diskette Drive
Problems

Table 2-18
Solving Diskette and Diskette Drive Problems

Problem Probable Cause Recommended Act ion(s)
Diskette drive cannot
read a diskette.

Diskette media has a
bad sector.

Copy remaining files to the hard
drive or another formatted diskette.
Reformat the diskette.

Using the wrong
diskette type for the
diskette drive type.

Use the required diskette type.

Diskette is not
formatted.

Format the diskette.
If you are using Windows 95:
1. From the Windows 95 desktop,

double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒
Format.

3. Fill in the appropriate information,
then click Start.

If you are using Windows NT,
format the diskette by entering
format a:  at the system prompt.

Diskette drive cannot
write to a diskette.

Diskette is not
formatted.

Format the diskette.
If you are using Windows 95:
1. From the Windows 95 desktop,

double-click My Computer.

2. Click 3 ½ Floppy (A:) ⇒ File ⇒
Format.

3. Fill in the required information,
then click Start.

If you are using Windows NT,
format the diskette by entering
format a:  at the system prompt.

Diskette is write-
protected.

Use another diskette that is not
write-protected or disable the write-
protect feature.

Writing to the wrong
drive.

Check the drive letter in your path
statement.

Not enough space is left
on the diskette.

Save the information to another
diskette.

Disable diskette write
ability is turned on.

Run Computer Setup. Click on the
Storage icon. Make sure Disable
diskette write ability is not checked.
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2.6.1.5 Solving Hard Drive Problems

CAUTION:   To prevent loss of information, always maintain an up-to-date
backup of the hard drive.

Table 2-19
Solving Hard Drive Problems

Problem Probable Cause Recommended Act ion(s)

Cannot access hard
drive.

Hard drive is not seated. Shut down the computer, remove
and reinsert the hard drive, then turn
on the computer.

Hard drive was inserted
while computer was on,
in Suspend, or in
Hibernation.

Shut down the computer, then turn it
on again to initialize it during power
on.

Hard drive may be
damaged.

Try inserting another hard drive.

Reading hard drive
takes an unusually long
time after restarting the
computer.

Hibernation was initiated
and system is now
exiting from it.

Give the system time to restore the
previously saved data.

Hard drive error occurs. Hard drive has bad
sectors or has failed.

Do one of the following:
■ If you are running Windows 95,

access ScanDisk by clicking
Start ⇒ Programs ⇒
Accessories ⇒ System Tools ⇒
ScanDisk, then check the
Automatically fix errors box.
Click Start to begin scanning.
If you are running Windows NT,
go to the system prompt and
type chkdsk  to scan for errors.

■ Reformat the hard drive.

Hard drive error occurs. Hard drive may be
damaged.

Try inserting another removable
drive, if the hard drive is in the
MultiBay.

Errors occur after
starting from an
additional hard drive.

Additional hard drive
does not have the
software and drivers
necessary to boot and
operate correctly.

Boot from the hard drive supplied
with the computer or another hard
drive that has the necessary
software and drivers.

Hard drive does not
work.

Hard drive is not seated. Turn off and unplug the computer,
remove the hard drive, then reinsert
it.
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2.6.1.6 Solving Hardware Installation Problems

Table 2-20
Solving Hardware Installation Problems

Problem Probable Cause Recommended Act ion(s)
New device is not
recognized as part of
the computer system.

The system did not
automatically configure
the new device.

In Windows 95, double-click the Add
New Hardware icon in Control Panel.

Refer to the documentation that
came with the new device for
installation instructions.

Cable(s) of new
external device are
loose or power cables
are unplugged.

Ensure that all cables are properly
and securely connected and the
power cord is plugged into an
electrical outlet.

Power switch of new
external device is not
turned on.

1.Turn off the computer.

2.Turn on the external device.

3.Turn on the computer to integrate
the device with the computer
system.

New device is not
configured for Windows
NT.

Use Computer Setup to view
settings for the new device or to
reset the configuration settings for
preinstalled devices.
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2.6.1.7 Solving Infrared Connection Problems
NOTE:  The computer is shipped with the infrared port disabled. The port must be
enabled each time the computer is started or restarted. Follow these steps to enable the
infrared port.

1. Click Start ⇒ Settings ⇒ Control Panel.
2. Double click the Infrared icon.
3. Select the Options tab.
4. Check the box labeled Enable Infrared Communications to select the Com3 port.
5. Click OK. The infrared icon appears on the task bar.

NOTE:  Windows NT does not support infrared communication.

Table 2-21
Solving Infrared Connection Problems

Problem Cause Recommended Act ion(s)

Cannot link with another
computer.

Interrupt request (IRQ)
conflict

Check IRQ assignments for
conflicts and reassign as
necessary.

Baud rate conflict Select the same baud rate for both
computers.

# bits conflict Select the same “#bits” setting for
both computers.

Stop bit conflict Select the same stop byte for both
computers.

Parity conflict Select the same parity setting for
both computers.

Data transmission
problem

Direct sunlight,
fluorescent light, or
flashing incandescent
light is close to the
infrared connections.

Remove the interfering light
sources.

Interference from other
infrared devices

Keep remote control units and other
infrared devices away from the
infrared connections.

Physical obstruction Do not place objects between the
two units that will interfere with a
line-of-sight data transmission.

Movement Do not move either unit during data
transmission.

Orientation Adjust devices so that they point
within 30 degrees of each other.

Distance Verify that devices are not more
than 3 feet (1 meter) apart.

Cannot connect at 4
MB/sec

Fast IR driver not
installed

Fast-IR is not preinstalled.
Download FAST-IR driver from
Compaq web site and install.
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2.6.1.8 Solving Modem Problems

Table 2-22
Solving PC and Modem Problems

Problem Probable Cause Recommended Act ion(s)

Modem loses
connection.

The connection from the
phone line to the
modem is loose.

Check to make sure the telephone
cable is properly connected.

Call Waiting has not
been disabled.

Disable Call Waiting.

1. Click Start ⇒ Control Panel ⇒
double-click Modems.

2. From the General tab of the
Modems Properties page, click
Dialing Properties.

3. From the My Locations tab of the
Dialing Properties page, check the
box labeled This location has
call waiting.  Select *70, 70#, or
1170 from the drop-down list to
disable call waiting for your dialing
area.

Noisy telephone line Phone line noise
causing garbled or
missing characters, or
slow data transfer
speeds.

Check your telephone and modem
cable connections. If they are a little
loose, they can cause noise on the
line.

Check with your local telephone
company for a phone line filter.

Phone line noise
causing a disconnection.

Hang-up Delay S
Register (S10) set too
low.

Change S10 default to 150.

1. Click Start ⇒ Programs ⇒
Accessories ⇒ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press
Enter.

This command causes the modem
to take longer to disconnect even if
there is noise on the line.

Continued
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Table 2-22 Continued

Problem Probable Cause Recommended Act ion(s)

No dial tone Phone service is not
connected to the
telephone wall jack.

Verify service from the local phone
company:
1. Unplug the telephone cable from

the telephone wall jack.

2.Connect a telephone to the jack,
pick up the handset, and listen for
a dial tone. If there is a dial tone,
reconnect the modem to the
telephone wall jack with the
telephone cable and make sure
all connections are secure.

3. If there is still no dial tone,
contact your local phone
company or building manager.

The modem is not
responding to
commands from the
computer keyboard.

Verify the modem and computer are
connected:
1.Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.

2.Go to Terminal Mode, then type
AT and press the Enter key.

If the modem displays OK, the
modem and computer are
working together. If the modem
displays ERROR, or does not
respond, restart the computer
and repeat step 1.

3.Type ATDT and listen for a dial
tone.

4. Type ATH0 (zero) to hang up.

Speaker Control AT
Command (ATM) is set
to 0.

Set the Speaker Control to 1:
1.Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.

2. Go to Command Mode, type
ATM1 and press Enter.

3. Type ATH1 and listen for a dial
tone.

4. Type ATH0 (zero) to hang up.

The modem is plugged
into a digital PBX line
rather than an analog
line.

Plug the modem into an analog line.
If you are in an office, the analog line
is often the one connected to a fax
machine or modem. To get an
analog line in a hotel, request a
room with a “data” line.

Characters are garbled
and transfer rates are
slow.

There is noise in the
telephone line.

■ Check your telephone and
modem cable connections. If
they are loose, they can cause
noise on the line.

■ Check with your local telephone
company for a phone line filter.

Continued
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Table 2-22 Continued

Problem Probable Cause Recommended Act ion(s)
Phone line noise causes
a disconnection.

Hang-Up Delay S
Register (S10) set too
low.

Change S10 default to 150.
1. Click Start ⇒ Programs ⇒

Accessories ⇒ HyperTerminal.

2. Go to Command Mode.

3. Type ATS10=150 and press
Enter.

This command causes the modem
to take longer to disconnect even if
there is noise
on the line.

Ten-digit dialing does not
work correctly under
Windows 95.

Ten-digit dialing doesn’t
work correctly under
Windows 95, making it
difficult to dial numbers
in a different area code
that are not long
distance calls.

Since Windows 95 does not limit the
number of digits you can enter in the
Phone Number field, set the Area
Code field to match your local area
code. Then type the ten-digit
telephone number in the Phone
Number field.

Modem cable
disables/interferes with
other telephony devices
(Germany, Austria, and
Switzerland only).

The modem cable does
not provide the
additional 4-wire
connection required in
Germany, Austria, and
Switzerland to form the
serial pass-through
necessary so that other
devices can work on the
same phone line.

To use another telephony device on
the same line in these countries,
unplug the modem cable from the
wall jack first.
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Modem does not dial
correctly under Windows
95 (Switzerland and
Germany only).

The “Wait for dial tone
before dialing”  check
box is checked. This
causes Windows 95 to
issue an ATDT;
command. A typical dial
string would look like
this:
ATDT;
ATDTnnn-nnnn
In Germany and
Switzerland, the ‘ ;’  dial
modifier is not permitted
to be used in this fashion
by regulatory agencies
since ATDT; takes the
modem off-hook without
dialing. Therefore, the
modem returns an error
message when
attempting to dial. The
error message reads:
“The computer is not
receiving a response
from the modem. Check
that the modem is
plugged in, and if
necessary, turn the
modem off, then turn it
back on.”

1. Click Start ⇒ Settings ⇒ Control
Panel.

2. Double-click the Modems icon.

3. Click the Properties button.

4. Select the Connection tab.

5. Click the “Wait for dial tone
before dialing”  check box to clear
it.

6. Click OK ⇒ Close.
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2.6.1.9 Solving PC Card Problems

Table 2-23
Solving PC Card Problems

Problem Probable Cause Recommended Act ion(s)

Computer does not
beep when PC Card is
inserted but PC Card
works correctly.

System beeps are
turned down.

PC Card sound effects
have been disabled.

Press Fn+F5, then press the right
arrow key to increase the system
beeps volume.

In Windows 95, double-click PC
Card icon ⇒ Global Settings tab.
Deselect Disable PC Card Sound
Effects.

Computer does not beep
when PC Card is
inserted and PC Card
does not work.

PC Card is not inserted
properly.

The PC Card slots have
been disabled.

Remove and reinsert the card
gently to
avoid damaging the pins.

Run Computer Setup to enable the
PC Card slots. When the system
starts, press F10 then select
Computer Setup ⇒ Other Devices ⇒
PC Card Controller ⇒ Resources.
Deselect the “Disabled” check box.

In Windows 95, click Start ⇒
Settings ⇒ Control Panel ⇒
System ⇒ Device Manager ⇒
PCMCIA Socket. Double-click the
Texas Instruments TI-1131 CardBus
controller to view device properties.
Deselect the “Disable in this
hardware profile” check box.

Card or card driver is
not compatible with the
computer or with the
operating system.

Contact service provider for a list of
compatible PC Cards.

Computer beeps twice,
but modem and/or fax
does not work.

Telephone cord is not
plugged in all the way.

Verify that the telephone connection
is secure.

The wrong COM port is
being used to access
the card.

Verify the COM port assigned to the
card and within the application is
correct.

In Windows 95, click Start ⇒ Help ⇒
Contents ⇒ Troubleshooting ⇒
Problem. Follow the instructions on
the screen.

Computer beeps twice
but network card does
not work.

Network server is
unavailable.

Contact system administrator.

Computer beeps twice
when a storage card is
inserted, but the card
does not work.

The wrong drive letter is
being used to access
the storage card.

Open Windows Explorer and verify
the drive letter.

PC Card does not work Windows NT was
running when the PC
Card was inserted.

Turn off the computer and reinsert
the PC Card.
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2.6.1.10 Solving Power Problems

Table 2-24
Solving Power Problems

Problem Probable Cause Recommended Act ion(s)
Computer will not turn
on.

Computer is not
connected to a power
source.

Insert battery pack or connect an
external power source.

Power cord to the
external power source is
unplugged.

Ensure that power cord connecting
the computer and the external
power source is plugged in properly.

Battery pack is
discharged.

Insert a fully charged battery pack or
connect an external power source.

CMOS data is corrupt Flush CMOS memory. See note on
page 11.

Computer will not turn
on when connected to
external power if battery
pack is in the computer.

Battery pack may be
defective.

Remove battery pack, insert
another battery pack, and try again.

Computer turned off
while it was left
unattended and the
power/suspend light is
off.

System initiated
Hibernation after a
preset timeout.

Turn on the computer to restore
information at the point where
Hibernation was initiated.
NOTE: To change the Hibernation
timeout setting in Windows 95, click
the Hibernation tab in Power
Properties. In Windows NT, run
Computer Setup and select Power
Management.

Computer turned off
while it was left
unattended and will not
turn on.

System initiated
Hibernation and/or shut
down because of a
critical low-battery
condition.

Replace the battery pack with a
fully charged battery pack or
connect an external power source,
then turn on the computer.

Computer initiated
Suspend or turned off
when it was docked.

The maximum
operating temperature
was exceeded.

Computer is in a high temperature
environment and the fan is not able
to cool it. Let the computer cool
down and turn it on again.
Make sure the ventilation intake
and exhaust are not obstructed.

Hibernation does not
work properly.

Hibernation was not
reset after a memory
upgrade.

Reset Hibernation in the Power
Management utility.

Computer does not turn
on when connected to
external power and no
batteries are installed.

Internal power supply is
bad.

Replace the internal power supply.
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2.6.1.11 Solving Screen Problems
IMPORTANT:   Conduct all tests on a working monitor. If the recommended actions
do not solve the problem, replace the display. If the problem persists with a new
display, replace the system board.

Table 2-25
Solving Screen Problems

Problem Probable Cause Recommended Act ion(s)
Characters are dim. The brightness or

contrast control (if
applicable) is not set
properly.

Adjust the control(s) with the
hotkeys: Fn+F9 and Fn+F10.

Computer screen is in
direct light.

Tilt the display or move computer.

Display is damaged. Replace the display.
Screen is blank. QuickLock/QuickBlank

was initiated.
Enter the password to exit
QuickLock/QuickBlank.

Screen save was
initiated after the Power
Management timeout
period.

Press any key or click the mouse.

Brightness or
contrast needs
adjusting.

Adjust the control(s) with the
hotkeys: Fn+F9 and Fn+F10.

Screen has overheated. If computer is in direct sunlight,
move it and allow it to cool.

Computer screen is
blank and the screen
on an external monitor
displays information.

Display was switched to
the external monitor.

Press the Fn+F4 hotkeys to display
information on the computer
screen.

Screen is blank and the
power/suspend light is
blinking.

System initiated
Suspend.

Press the suspend button to exit
Suspend. Enter the power-on
password if prompted.

Screen is blank and the
power/suspend light
and the battery light are
blinking.

System has entered a
critical low-battery
condition.

Immediately connect the computer
to an external power source or
replace the battery pack.

External monitor does
not display information.

External monitor was
connected after the
computer was turned
on.

Press the Fn+F4 hotkeys to switch
to the external monitor.

The external monitor
signal cable or power
cord is not properly
connected.

Ensure that the cables are properly
connected.

Small red, green, or
blue spots appear on
the computer CTFT
display.

Small spots, called on-
pixels, often appear on
CTFT screens. Compaq
limits the number of
these on-pixels to 0.003
percent.

No action is required.

Continued
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Table 2-25   Continued

Problem Probable Cause Recommended Act ion(s)
Display on an external
monitor is distorted.

Incorrect display device
drivers are installed or
incorrect resolution is
set.

Double-click the Display icon in
Control Panel, click the Settings
tab, and set the correct display type
and resolution for the external
monitor.

The external monitor is
not Energy Star
compliant, but monitor
energy saving feature is
enabled.

Complete these steps:
1. Press any key or move the

pointing device to restore the
display.

2. If display remains distorted, turn
off the monitor, then turn it on
again.

3. Disable the monitor energy
saving feature in Display
Properties or in Computer Setup
Power Management.

The image has a black
border and does not fill
the screen.

The Desktop Area
setting is smaller than
the Resolution setting.

Adjust the settings for the Desktop
Area and Resolution. Double-click
Control Panel Display ⇒ Settings
⇒ Compaq.
Press the Fn+T keys to expand the
image.

2.6.1.12 Solving USB Problems

Table 2-26
Solving USB Problems

Problem Probable Cause Recommended Act ion(s)
External device
connected to a USB
connector does
not work.

The operating system
limits external devices
connected by USB to
two tiers that can
include no more than
two hubs on the first tier
and no more than one
keyboard and one
pointing device on the
first or second tier.

Reduce the number of connected
external USB devices to no more
than two hubs on the first tier, and
no more than one keyboard and one
pointing device on the first or second
tier.

External device
connected to a USB
connector does not work
during startup (before
Windows 95 loads).

During startup, only two
tiers are supported by
the USB connector.
These tiers can include
no more than two hubs
on the first tier and no
more than one keyboard
and one pointing device
on the first or second
tier.

■ Use the external device only
after Windows 95 has loaded.

■ Reduce the number of
connected external USB devices
to no more than two hubs on the
first tier, and no more than one
keyboard and one pointing
device on the first or second
tier.
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External devices in
lower tiers do not work.

An unpowered hub is
connected to another
unpowered hub.

■ Use only powered hubs.

■ Make sure that all unpowered
hubs are immediately preceded
by powered hubs in the USB
chain.
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chapter
 3

ILLUSTRATED PARTS
CATALOG

This chapter provides illustrated parts and references for spare parts for the Compaq
Evergreen Family of Personal Computers. To review an illustrated parts breakdown of
the computer, refer to the Illustrated Parts Map that comes with this guide.
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3.1  System Unit

Figure 3-1.  System Unit
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Table 3-1
System Unit

Item Description Spares Part Number
1 12.1-inch CTFT display assembly 310367-001
* 13.3-inch CTFT display assembly 310368-001
2 Keyboard 310347-001
* Keyboard (Belgian) 310347-181
* Keyboard (Brazilian Portuguese) 310347-201
* Keyboard (Danish) 310347-081
* Keyboard (French) 310347-051
* Keyboard (French Canadian) 310347-121
* Keyboard (German) 310347-041
* Keyboard (Italian) 310347-061
* Keyboard (Japanese) 310347-292
* Keyboard (Korean Hanguel) 310347-AD1
* Keyboard (Latin American

Spanish)
310347-161

* Keyboard (Norwegian) 310347-091
* Keyboard (Portuguese) 310347-131
* Keyboard (Spanish) 310347-071
* Keyboard (Swedish) 310347-101
* Keyboard (Swiss English) 310347-111
* Keyboard (Taiwanese) 310347-AB1
* Keyboard (UK English) 310347-031
3 Top cover assembly 310370-001
4 Base enclosure assembly 310371-001

 *Not illustrated
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3.2  Mass Storage Devices

Figure 3-2.  Mass Storage Devices

Table 3-2
Mass Storage Devices

Item Description Spares Part Number
1 24x CD-ROM drive 310379-001
* DVD-ROM drive module 310336-001
2 4.0-GB hard drive 310344-001
* 6.4-GB hard drive 310365-001
* 6.4-GB hard drive (M35EU) 316269-001
3 1.44-MB, diskette drive 310378-001
* Cable assembly, diskette drive 310376-001
4 LS-120 drive module 310331-001
* 100-MB ZIP drive module 310341-001

*  Not illustrated
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3.3  Cables and Power Cords

Figure 3-3.  Cables and Power Cords

Table 3-3
Cables and Power Cords

Item Description Spares Part Number
1 AC power cord, 6’, black (US) 246959-001
* AC power cord, 6’, black

(Australia)
246959-011

* AC power cord, 6’, black
(Denmark)

246959-081

* AC power cord, 6’, black (Europe) 246959-021
* AC power cord, 6’, black (Italy) 246959-061
* AC power cord, 6’, black (Japan) 246959-291
* AC power cord, 6’, black (Korea) 246959-AD1
* AC power cord, 6’, black

(Singapore)
246959-AG1

* AC power cord, 6’, black (UK) 246959-031
2 External AC adapter 310362-001

*  Not illustrated
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3.4  Standard and Optional Boards

Figure 3-4.  Standard and Optional Boards

Table 3-4
Standard and Optional Boards

Item Description Spares Part Number
1 DC-DC voltage converter 310361-001
2 System board with 266-MHz Intel Pentium II  /

32-MB
310358-001

* System board with 300-MHz Intel Pentium II  /
32-MB

310359-001

* System board with 300-MHz Intel Pentium II  /
64-MB

310387-001

* System board with 300-MHz Intel Pentium II  /
64-MB

310388-001

3 Memory board (SODIMM), 32-MB, 60 ns, non
parity

313911-001

* Memory board (SODIMM), 64-MB, 60 ns, non
parity

313918-001
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* Memory board (SODIMM), 128-MB, 60 ns,
non parity

310345-001

* LED/Switch board 310398-001

*  Not illustrated
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3.5  Options

Figure 3-5.  Options

Table 3-5
Options

Item Description Spares Part Number
1 External battery charger 310346-001
2 Automobile/aircraft adapter 313919-001
3 Li-ion battery pack  (9 cell) 310357-001
* Li-ion battery pack  (6 cell) 310356-001
4 Mobile 3500 Expansion Unit 310342-001
* Hard drive adapter 310343-001
* Convenience Base II - pass

through
316291-001

* Convenience Base II - Ethernet 316312-001
* Convenience Base - 10-Base-T 254987-001
* Convenience Base  - pass

through
254988-001

* Convenience Base - 10-Base-T 254989-001
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* Monitor stand 316286-001

*  Not illustrated

3.6  Miscellaneous Parts

Figure 3-6.  Miscellaneous Parts
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Table 3-6
Miscellaneous Parts

Item Description Spares Part Number
1 Miscellaneous plastics kit :

a Memory compartment cover
b Display hinge covers
c M35EU connector cover
d Hard drive cover
e PC Card bay cover
* Status/Switch cover

310372-001

2 CMOS battery, NiMH 310382-001
3 RTC battery 310366-001
4 Fan 310363-001
5 Speaker 310377-001
* Screw kit 310373-001
* Logo kit 310375-001
* Country kit (North America) 310374-001
* Country kit (Europe)

*  Not illustrated
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3.7  Documentation

Table 3-7
Documentation

Description Spare Part Number
Illustrated Parts Map 316268-001
Maintenance and Service Guide 316272-001



Compaq Confidential - Need to Know Required

Removal and Replacement Preliminaries    4-1

chapter
 4

REMOVAL AND
REPLACEMENT
PRELIMINARIES

This chapter provides essential information for proper and safe removal and
replacement service.

4.1  Tools Required
You will need the following tools to complete the removal and replacement procedures:

■ Magnetic Torx T-8 screwdriver (for all screws unless otherwise specified)

■ 7-mm hex socket (for bushing guides)

■ Tool kit, Compaq part number 101089-001 (includes connector removal tool,
loopback plugs, and case utility tool)

■ Small flat-blade screwdriver (optional)

■ Scribe

■ Tweezers

4.2  Service Considerations
Listed below are some of the considerations that you should keep in mind during
disassembly and assembly procedures.

4.2.1 Plastic Parts
Using excessive force during disassembly and reassembly can damage plastic parts.
Use care when handling the plastic parts. Apply pressure only at the points designated
in the maintenance instructions.

IMPORTANT:  As you remove each subassembly from the computer, place it (and all
accompanying screws) away from the work area to prevent damage.
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4.2.2 Cables and Connectors
Handle cables with extreme care to avoid damage. Apply only the tension required to
unseat or seat the cables during removal and insertion. Handle cables by the connector
whenever possible. In all cases, avoid bending, twisting, or tearing cables. Route cables
in such a way that they cannot be caught or snagged by parts being removed or
replaced. Handle flex cables with extreme care; they tear easily.

CAUTION:  Place cables in their proper location during the
reassembly process. Improper cable placement can damage the
computer.

4.3  Preventing Damage to
Removable Drives

Removable drives are fragile components that must be handled with care. To prevent
damage to the computer, damage to a removable drive, or loss of information, observe
these precautions:

■ Before removing or inserting a hard drive, shut down the computer. If you are
unsure whether the computer is off or in Hibernation, turn the computer on, then
shut it down.

■ Before removing a diskette drive or CD-ROM drive, ensure that a diskette or disc is
not in the drive. Ensure that the CD-ROM tray is closed.

■ Before handling a drive, ensure that you are discharged of static electricity. While
handling a drive, avoid touching the connector.

■ Handle drives on surfaces that have at least one inch of shock-proof foam.

■ Avoid dropping drives from any height onto any surface.

■ Always place MultiBay drives in a carrying case when removed from the computer.

■ Do not use excessive force when inserting a drive into the MultiBay.

■ Avoid exposing a hard drive to products that have magnetic fields such as monitors
or speakers.

■ Avoid exposing a drive to temperature extremes or to liquids.

■ If a drive must be mailed, do the following:

– Place the hard drive into a bubble pack mailer or other suitable form of
protective packaging.

– Label the package “Fragile: Handle With Care.”
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4.4  Preventing Electrostatic
Damage

Many electronic components are sensitive to electrostatic discharge (ESD). Circuitry
design and structure determine the degree of sensitivity. Networks built into many
integrated circuits provide some protection, but in many cases the discharge contains
enough power to alter device parameters or melt silicon junctions.

A sudden discharge of static electricity from a finger or other conductor can destroy
static-sensitive devices or microcircuitry. Often the spark is neither felt nor heard, but
damage occurs anyway. An electronic device exposed to electrostatic discharge may
function normally for a while, then degrade in performance or fail early.

4.2.1 Packaging and Transporting Precautions
Use the following grounding precautions when packaging and transporting equipment:

■ To avoid hand contact, transport products in static-safe containers such as tubes,
bags, or boxes.

■ Protect all electrostatic-sensitive parts and assemblies with conductive or approved
containers or packaging.

■ Keep electrostatic-sensitive parts in their containers until they arrive at static-free
workstations.

■ Place items on a grounded surface before removing them from their container.

■ Always be properly grounded when touching a sensitive component or assembly.

■ Place reusable electrostatic-sensitive parts from assemblies in protective packaging
or non-conductive foam.

■ Use transporters and conveyers made of antistatic belts and roller bushings. Ensure
that mechanized equipment used for moving materials is wired to ground, and that
proper materials were selected to avoid static charging. When grounding is not
possible, use an ionizer to dissipate electric charges.
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4.2.2 Workstation Precautions
Use the following grounding precautions at workstations:

■ Cover the workstation with approved static-dissipative material (refer to Table 4-2
later in this chapter).

■ Use a wrist strap connected to a properly grounded work surface and use properly
grounded tools and equipment.

■ Use field service tools, such as cutters, screwdrivers, and vacuums that are
conductive.

■ When using fixtures that must directly contact dissipative surfaces, use fixtures
made of static-safe materials only.

■ Keep work area free of nonconductive materials such as ordinary plastic assembly
aids and Styrofoam.

■ Handle electrostatic-sensitive components, parts, and assemblies by the case or PCM
laminate. Handle them only at static-free workstations.

■ Avoid contact with pins, leads, or circuitry.

■ Turn off power and input signals before inserting or removing connectors or test
equipment.
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4.2.3 Grounding Equipment and Methods
Grounding equipment must include either a wrist strap or a foot strap at a grounded
workstation.

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are
flexible straps with a minimum of one megohm ±10% resistance in the ground
cords. To provide proper ground, a strap must be worn snug against the skin. On
grounded mats with banana-plug connectors, connect a wrist strap with alligator
clips.

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or
boot straps) can be used at standing workstations and are compatible with most types
of shoes or boots. On conductive floors or dissipative floor mats, use them on both
feet with a minimum of one-megohm resistance between the operator and ground.
To be effective, the conductive strips must be worn in contact with the skin.

Other grounding equipment recommended for use in preventing electrostatic damage
include:

■ Antistatic tape

■ Antistatic smocks, aprons, or sleeve protectors

■ Conductive bins and other assembly or soldering aids

■ Non-conductive foam

■ Conductive tabletop workstations with ground cord of one-megohm resistance

■ Static-dissipative table or floor mats with hard tie to ground

■ Field service kits

■ Static awareness labels

■ Material-handling packages

■ Non-conductive plastic bags, tubes, or boxes

■ Metal tote boxes
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4.2.4 Electrostatic Voltage Levels and
Protective Materials

Table 4-1 shows how humidity affects the electrostatic voltage levels generated by
different activities.

Table 4-1
Typical Electrostatic Voltage Levels

Relative Humidity

Event 10% 40% 55%
Walking across carpet 35,000 V 15,000 V 7,500 V
Walking across vinyl floor 12,000 V  5,000 V 3,000 V
Motions of bench worker  6,000 V    800 V   400 V
Removing DIPS from plastic tube  2,000 V    700 V   400 V
Removing DIPS from vinyl tray 11,500 V  4,000 V 2,000 V
Removing DIPS from Styrofoam 14,500 V  5,000 V 3,500 V
Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V
Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V

NOTE: 700 volts can degrade a
product.

Table 4-2 lists the shielding protection provided by antistatic bags and floor mats.

Table 4-2
Static-Shielding Materials

Material Use Voltage Protection L evel
Antistatic plastic Bags  1,500 V
Carbon-loaded plastic Floor mats  7,500 V
Metallized laminate Floor mats 15,000 V
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chapter
 5

REMOVAL AND
REPLACEMENT
PROCEDURES

This chapter provides the removal and replacement procedures for the computer
subassemblies.

5.1 Serial Number
The computer serial number should be provided to Compaq support when requesting
information or ordering spare parts. The serial number 1 is located on the bottom of the
computer (Figure 5-1).

Figure 5-1.  Serial Number Location
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5.2 Disassembly Sequence
Refer to the disassembly steps before disassembling the computer. Disassemble only
the components necessary to gain access to the sub-assembly you are servicing.

5.3  Preparing the Computer for Di sassembly
5.3.1 Disconnecting the AC Power
5.3.1.1 Removing the Computer From the Convenience Base
5.3.1.2 Disconnecting the Computer from the M
5.3.3 Removing the Battery Pack
5.3.2 Removing the PCMCIA Card

5.4 Memory Board
5.4.1 Removing the Memory Module
5.4.2 Installing the Memory Module

5.5 Hard Drive
5.5.1 Removing the Hard Drive Cover
5.5.2 Removing the Lithium Real Time Clock Battery
5.5.3 Removing the Nickel Cadmium Standby Battery
5.5.4 Removing the Hard Drive

5.6 Keyboard

5.7 Display Assembly
5.7.1 Removing the Display Hinge Covers
5.7.2 Removing the Switch Cover
5.7.3 Removing the Display Assembly

5.8 Top Co ver Assembly
5.8.1 Removing the DC-DC Converter
5.8.2 Removing the System Board
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5.3  Preparing the Computer for
Disassembly

Before beginning the removal and replacement procedures, complete the following:

1. Disconnect the modem line cord.
2. Disconnect the AC power and any external devices.

! WARNING:   To reduce the risk of personal injury from hot surfaces, allow
the internal system components to cool before touching.

5.3.1 Disconnecting the AC Power
Before beginning service procedures on the computer, remove all power from the
system to prevent damage to the equipment or personal injury. Select the appropriate
steps, depending on whether the computer is docked or not.

5.3.1.1 Removing the Computer From the
Convenience Base
If the computer is docked in the convenience base, it must be undocked before
performing additional work. Complete the following steps to undock the computer.

1. Close all applications and exit the operating system.
2. Turn off the computer and the convenience base.
3. Disconnect the AC power and any external cables.
4. Close the computer.
5. Pull the docking lever 1 forward to undock the computer.
6. Release the retaining latch.
7. Lift the computer from the convenience base.

Figure 5-2.  Undocking the Computer
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5.3.1.2 Disconnecting the Computer from the
Mobile 3500 Expansion Unit
After undocking the computer, begin with step 6. If the computer is not docked,
perform the following steps:

1. Close all applications and exit the operating system.
2. Turn off the computer 1 by depressing the power switch.
3. Turn off and disconnect any external devices.
4. Disconnect the AC power cord from the power source.
5. Disconnect the AC power cord from the computer.
6. Pull the release lever 2 on the Mobile 3500 Expansion Unit (M35EU) to release the

computer.
7. Disconnect the connectors 3 by lifting the computer from the back corners.

Figure 5-3.  Disconnecting the Computer From the Mobile Expansion
Unit
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1. Slide the expansion slot cover to the closed position.

Figure 5-4. Closing the Expansion Slot Cover

Reverse the procedure to connect the computer to the M35EU.
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5.3.2 Removing the PCMCIA Card
Remove any installed PC (PCMCIA) Cards before performing any service on the
computer. To remove a PC Card, complete the following steps:

1. Open PC Card door 1.
2. To eject the PC Card, firmly depress the PC Card eject button 2.
3. Remove the card 3.

Figure 5-5.  Removing the PC Card
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5.3.3 Removing the Battery Pack
Remove the battery pack before beginning any internal maintenance on the computer.

! WARNING:   Metal objects can damage the battery pack as well as the
battery contacts in the battery compartment. To prevent damage, do not
allow metal objects to touch the battery contacts. Place only the battery
pack for the Compaq Armada Personal Computer into the battery
compartment. Do not force the battery pack into the bay.

! WARNING:   Do not crush, puncture, or incinerate the battery pack. Do
not dispose of in water. Do not expose to temperatures higher than 60°C.
Do not open a battery pack, as this damages the pack, makes it
unserviceable, and exposes potentially harmful battery components.
There are no field-serviceable parts located inside the battery pack.

To remove the battery pack from the computer, complete the following steps:

1. Open the display to release the battery.

CAUTION:  Failure to open the display before removing or inserting the
battery pack can result in damage to the battery pack retention features.
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2. Slide the battery pack retainer up to release the battery pack 1.
3. Pull the battery pack 2 out of the computer.

Figure 5-6.  Removing the Battery Pack



Compaq Confidential - Need to Know Required

Removal and Replacement Procedures    5-9

5.4 Memory Board
If a memory expansion board option has been previously installed in the computer, it
must be removed before another is installed. To remove the memory board, complete
the following steps:

1. Prepare the computer for disassembly (Section 5.3).
2. Place the computer bottom side up on the table with the front of the unit facing you.
3. Remove the optional security screw.
4. Lift the right edge of the memory compartment cover and remove it from the

computer.

Figure 5-7.  Lifting the Memory Compartment Cover
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5.4.1 Removing the Memory Module
1. Pull out the right and left locking tabs 1 on each end of the memory expansion

board. This releases the memory board and allows it to rotate upward to ease
removal.

CAUTION:   If you need to remove the memory expansion board, be sure
to release the locking tabs that secure the memory board in the slot. The
connectors may break and cause irreparable damage to the system board
if the tabs are not released.

Figure 5-8.  Releasing the Memory Expansion Board

2. Rotate the free edge 2 of the memory module upward.
3. Pull the memory module from the slot at a 45 degree angle to the system board.
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5.4.2 Installing the Memory Module
To install a memory board, complete the following steps:

1. Insert the memory board 1 into the memory slot.
2. Rotate the free edge of the memory board toward the computer 2 so that it lays flat

in the memory compartment.
3. Press the memory board firmly into place to seat the connections and to engage the

locking tabs.

Figure 5-9.  Installing the Memory Board

Reinstall the memory compartment cover by placing the left edge in the compartment
and pressing the right edge toward the system unit. Press it firmly into position until
the locking tabs secure the cover into position. Replace the security screw, if one was
removed during disassembly.
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5.5 Hard Drive
The hard drive cover retains the hard drive, the standby battery, and the RTC battery in
place.

5.5.1 Removing the Hard Drive Cover
A security screw holds the hard drive cover in place. To remove the hard drive cover,
complete the following steps:

1. Prepare the computer for disassembly (Section 5.3).
2. Turn the computer bottom side up and position it so that the right side of the unit is

toward you.
3. Remove the screw from the drive cover.
4. Slide the cover towards you and lift the cover from the computer.

Figure 5-10.  Removing the Hard Drive Cover Security Screw
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5.5.2 Removing the Lithium Real Time Clock
Battery

! WARNING:   There is a risk of explosion and injury if the battery is
incorrectly replaced or handled improperly. Do not attempt to  recharge,
disassemble, immerse in water, or dispose of it in fire. Replacement
should be done using the Compaq spare part for this computer.

To remove or  replace the RTC battery, complete the following procedures.

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the hard drive cover.
3. Disconnect the RTC battery connector
4. Lift the RTC battery from the hard drive bay.

CAUTION:   To prevent damaging the battery, do not pull on the battery
cable.

4. Using tweezers, disconnect the RTC battery from the system unit.

Figure 5-11.  Removing the RTC Battery

Reverse the procedure to install a replacement RTC battery.
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5.5.3 Removing the Nickel Cadmium Standby
Battery

! WARNING:   There is a risk of explosion and injury if the battery is
incorrectly replaced or handled improperly. Do not attempt to  recharge,
disassemble, immerse in water, or dispose of it in fire. Replacement
should be done using the Compaq spare part for this computer.

To remove or replace the standby battery, complete the following procedures.

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the hard drive cover.
3. Disconnect the standby battery connector.
4. Lift the standby battery from the hard drive bay.

CAUTION:   To prevent damage to the battery assembly, do not pull on
the battery cable.

4. Using tweezers, disconnect the standby battery from the system unit.

Figure 5-12.  Removing the Standby Battery

Reverse the procedure to install a replacement standby battery.
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5.5.4 Removing the Hard Drive
To remove the hard drive, complete the following procedures.

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the hard drive cover.
3. Free the tab on the hard drive from the hard drive bay.
4. Slide the hard drive away from the connector, and lift it from the computer with the

tab.

Figure 5-13.  Removing the Hard Drive

Reverse the procedure to re-install the hard drive.
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5.6 Keyboard
To remove the keyboard, complete the following procedures.

1. Prepare the computer for disassembly (Section 5.3).
2. Place the computer on a level workspace with the front of the unit facing you.
3. Open the display to the vertical (perpendicular to workspace to prevent tipping of the

unit)  position.
4. To release the keyboard, insert the tip of a small screwdriver into the groove above

each of the four keyboard latches and slide the latch towards you.
5. Lift the back edge of the keyboard.  Be careful not to stress the cables.

Figure 5-14.  Releasing the Keyboard Latches
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6. Slide the keyboard toward you to gain access to the keyboard and pointing device
cable.

7. Using tweezers or the tip of a scribe, release the latch on the keyboard and pointing
device ZIF connectors.

8. Disconnect the keyboard and pointing device cables.
9. Lift the keyboard from the system unit.

Figure 5-15.   Disconnecting the Keyboard and Pointing Device Cable

To replace the keyboard, reverse the procedure above.
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5.7 Display Assembly
To remove the display assembly, complete the following steps:

5.7.1 Removing the Display Hinge Covers
1. Prepare the computer for disassembly (Section 5.3).
2. Place the computer on the table right side up and with the rear facing you.
3. Slide the hinge covers away from the system unit.

Figure 5-16.  Removing the Hinge Covers
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5.7.2 Removing the Switch Cover/Status Panel
1. Prepare the computer for disassembly (Section 5.3).
2. Remove the keyboard (Section 5.6).
3. Close the display.
4. Remove the hinge covers (Section 5.7).
5. Place the computer bottom side up and with the front of the unit toward you.
6. Remove the screw from the left rear corner of the unit.

Figure 5-17.  Removing the switch cover screw
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7. Turn the computer right side up with the front of the unit toward you.
8. Open the display.
9. Lift the switch cover / status panel from the computer.

Figure 5-18.  Removing the switch cover/status panel

To replace the switch cover, reverse the procedure above.
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5.7.3 Removing the Display Assembly

CAUTION:   Do not reuse the hinge screws removed from the previously
installed display. These screws may back out of the display hinges and
cause the display assembly to loosen from the base enclosure.

To remove the display assembly, complete the following procedure:

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the keyboard (Section 5.5).
3. Remove the hinge covers (Section 5.7).
4. Remove the switch cover assembly  (Section 5.7).
5. Using tweezers, separate the backlight power cable and the display cable from the

system board.

Figure 5-19.  Disconnecting the Display Cables

NOTE:  Do not pull the connector from the socket by the wires. Pulling on the wires
may damage them, rendering the display inoperative.
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6. Close the display.
7. Remove the two screws from the left display clutch and the two screws from the

right display clutch.
8. Lift the display assembly from the base enclosure.

Figure 5-20.  Removing the Display Assembly

Reverse the procedure to replace the display assembly.

Note:  Always replace the four loctite screws with the replacement screws supplied in
the service kit.
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5.8 Top Cover Assembly
To remove the top cover assembly, complete the following procedures:

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the keyboard (Section 5.6).
3. Remove the hinge covers (Section 5.7).
4. Remove the switch cover assembly  (Section 5.7).
5. Remove the display assembly (Section 5.7).
6. Turn the computer bottom side up.
7. Remove the seven (7) screws from the bottom of the system unit.

Figure 5-21.  Removing the screws from the bottom of the system
unit
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8. Remove the screw from the rear of the unit.
9. Remove the two screws from the top of the cover.
10. Lift the top cover from the system base unit.

 

Figure 5-22.  Removing the Top Cover Assembly
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5.8.1 Removing the DC-DC Converter
To remove the DC-DC converter, complete the following procedures:

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the keyboard (Section 5.6).
3. Remove the display assembly (Section 5.7).
4. Remove the top cover assembly (Section 5.8).
5. Remove the screw from the converter board.
6. Remove the DC-DC converter

Figure 5-23.  Removing the DC-DC Converter
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5.8.2 Removing the System Board
To remove the system board, complete the following procedures:

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the lithium real-time clock battery (Section 5.5).
3. Remove the standby battery. (Section 5.5).
4. Remove the hard drive (Section 5.5).
5. Remove the memory module (Section 5.4).
6. Remove the keyboard (Section 5.6).
7. Remove the display assembly (Section 5.7).
8. Remove the top cover assembly (Section 5.9).
9. Remove the DC-DC Converter (Section 5.9).

10. Remove the three screws from the system unit.

11. Remove the docking guides from the rear panel.

12. Lift the right edge of the system board to a 45 degree angle and lift from the base enclosure.

Figure 5-24.  Removing the System Board

To replace the system board, reverse the steps.
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5.8.3 Removing the Fan
To remove the fan, complete the following procedures:

1. Prepare the computer for disassembly (Section 5.3).
2. Remove the lithium real-time clock battery (Section 5.5).
3. Remove the standby battery. (Section 5.5).
4. Remove the hard drive (Section 5.5).
5. Remove the keyboard (Section 5.6).
6. Remove the display assembly (Section 5.7).
7. Remove the top cover assembly (Section 5.9).
8. Remove the fan.

Figure 5-25.  Removing the Fan

To replace the fan, reverse the steps.

Note:  It is not necessary to remove the system board to replace the fan.
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chapter
 6

SPECIFICATIONS

This chapter provides physical and performance specifications for the following:

■ Computer

■ Displays

■ Hard drives

■ Diskette drive

■ LS-120 drive

■ ZIP drive

■ CD-ROM drive

■ DVD-ROM drive

■ Battery packs

■ Convenience Base II

■ External power sources

The chapter also includes:

■ System interrupts

■ System DMA

■ System I/O address

■ System memory map
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6.1  Computer
Table 6-1

Computer Specifications
    U.S. Metric

Dimensions (without M35EU)
  Height
  Depth
  Width

1.31 in
9.25 in

11.81 in

3.35 cm
23.5 cm
30.0 cm

Dimensions (with M35EU)
  Height
  Depth
  Width

2.06 in
9.25 in

11.81 in

5.25 cm
23.5 cm
30.0 cm

Weight (without M35EU)
  With battery and optional CD-ROM 4.4 lbs. 2.0 kg
Standalone (Battery) Power
Requirements
  Nominal Operating Voltage (Li-Ion) 14.2 14.2
  Nominal Operating Voltage (NiMH) 9.6 9.6
  Maximum Operating Power 45 W 45 W
  Peak Operating Power 50 W 50 W
Integrated AC Power Power
Requirements
  Operating Voltage 100 to 240 VAC RMS 100 to 240 VAC

RMS
  Operating Current 1.1 A RNS 1.1 A RMS
  Operating Frequency Range 47 to 63 Hz AC 47 to 63 Hz AC
  Maximum Transient 4/50 kV 4/50 kV
Temperature
  Operating 5 to

95°F
  10 to 35°C

  Non-operating -4 to
140°F

-30 to 60°C

Relative Humidity (non-condensing)
  Operating 10 to 90% 10 to 90%
  Non-operating  (tw = 38.7°C max)   5 to 90%   5 to 90%
Altitude
  Operating 0 to 10,000 ft 0 to 3.15 km
  Non-operating 0 to 30,000 ft 0 to 10.14 km
Shock
  Operating   10 G, 11 ms, half sine
  Non operating   240 G, 2 ms, half sine
Vibration
  Operating 0.55 G, 0.25 Oct/Min sweep rate
  Non-operating 1.5 G, 0.5 Oct/Min sweep rate

NOTE:  Applicable product safety standards specify thermal limits for plastic
surfaces. The Compaq Armada operates well within this range of temperatures.
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6.2  Display

Table 6-2
12.1-Inch CTFT, SVGA Display

U.S. Metric
Dimensions
  Height
  Width

7.24 in
9.7 in

18.4 cm
24.6 cm

Number of Colors 64K
Contrast Ratio 100:1 minimum
Pixel Resolution
  Pitch
  Format
  Configuration

0.30 × 0.30 mm
800 × 600
RGB Stripe

Backlight Edge Lit
Character Display 80 × 25

Table 6-3
13.3-Inch CTFT, XGA Display

U.S. Metric
Dimensions
  Height 7.9 in 20.1 cm
  Width 10.6 in 26.9 cm
Number of Colors 64K
Contrast Ratio 100: 1 minimum
Pixel Resolution
  Pitch
  Format
  Configuration

0.29 x 0.29 mm
1024 x 768
RGB Stripe

Backlight Edge Lit
Character Display 80 × 25
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6.3 Hard Drives

Table 6-4
Hard Drive Specifications

Standard Model
Configurations

4.0-GB 6.0-GB 6.0-GB

Formatted Capacity per Drive
(MB)
  Physical
  Logical 4,099,866,624
Drive Type
Drive Height
  With drive frame (mm) 9.5 12.7 12.7
Drive Size
  Inches 2.5 x 0.5 2.5 x 0.5 2.5 x 0.5
  Millimeters 102 x 75 102 x 75 102 x 75
Transfer Rate
  Media (Mb/s) 51.4-83.4
  Interface (Mb/s) 16.6
Sector Interleave 1:1 1:1 1:1
Typical Seek Time
(Including setting)
  Single Track (ms) 4 ms
  Average (ms) 13 ms (read)
  Full Stroke (ms) 32 ms (read)
Disk Rotational Speed (RPM) 4009
Physical Configuration
  Cylinders 6975
  Data Heads 6
  Sectors/Track 144-240
  Bytes/Sector 512
Logical Configuration
  Cylinders 7944
  Heads 16
  Sectors per Track 63
  Bytes per Sector 512
Buffer Size 512-KB
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6.4 Diskette Drive

Table 6-5
Diskette Drive Specifications

Diskette size 3.5-inch
  High density 1.44-MB/1.2-MB
  Low density 720 KB
Light None
Height 0.43-in (11 mm)
Bytes per sector 512
Sectors per Track
  High density 18 (1.44-MB)/15 (1.2-MB)
  Low density   9
Tracks per Side
  High density 80 (1.44-MB)/80 (1.2-MB)
  Low density 80
Read/Write heads   2
Average Seek Times
  Track-to-Track (high/low)     3 ms/6 ms
  Average (high/low)   94 ms/174 ms
  Settling Time   15 ms
  Latency Average 100 ms
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6.5 Optical Disk Drives

Table 6-6
CD-ROM Specifications

Applicable Disc CD-ROM mode 1, mode 2
CD-Digital Audio
CD-XA mode 2 (Form 1, Form 2)
CD-I mode 2 (Form1, Form 2)
CD-I Ready
CD-Bridge
CD-WO (fixed/variable packets)
Photo CD (singlemultisession)

Center Hole Diameter 15 mm
Disc Diameter 12 cm, 8 cm
Disc Thickness 1.2 mm
Track Pitch 1.6  µm
Laser
  Beam Divergence 53.5 ± 1.5 degrees
  Output Power 0.24 ± 0.1 mw
  Type Semiconductor Laser GaA1As
  Wave Length 780 nm ± 25 nm
Access time
  Random <350 ms
  Full Stroke <750 ms
Audio output level
  Line Out 0.7 Vrms
  Headphone None
Cache buffer 128 KB
Data transfer rate
  Sustained, 10x 1500 KB/sec
  Sustained, single 150 KB/sec
  Burst 8.3 MB/sec
  Startup Time <8 seconds typical
Capacity
Mode 1, 12 cm 550 MB
Mode 2, 12 cm 640 MB
8 cm 180 MB
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The external battery charger charges the Li-Ion battery outside the computer. It may
also be used to charge spare batteries.

Table 6-7
External Battery Charger with AC Adapter

6-Cell 9-Cell

U.S. Metric U.S. Metric
Dimensions
  Height
  Width
  Length
Weight
Power Supply
(Input)
  Nominal
Voltage

90 to 264 VAC 90 to 264 VAC

  Line frequency 47-63 Hz 47-63 Hz
Power Supply
(Output)
  Nominal
Voltage

+15.0 +/- 0.5 VDC +15.0 +/- 0.5 VDC

  Power 35 to 40 W 35 to 40 W
Temperature
  Operating 32° to 104°F 0° to 40°C 32° to 104°F 0° to 40°C
  Nonoperating -4° to 185°F -20° to +65°C -4° to 185°F -20° to +65°C
Relative
Humidity
  Operating 20% to 95% 20% to 95%
  Nonoperating 20% to 95% 20% to 95%
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6.6 System Interrupts

Table 6-8
Hardware Interrupts

Hardware IRQ System Function
IRQ0 Timer interrupt
IRQ1 Keyboard
IRQ2 Interrupt controller cascade
IRQ3 COM 2
IRQ4 COM 1
IRQ5 Audio
IRQ6 Diskette Drive controller
IRQ7 EPP Parallel
IRQ8 Real-Time Clock (MSIO)
IRQ9 PCI devices
IRQ10 Unused
IRQ11 Used by PCMCIA
IRQ12 Mouse
IRQ13 Floating point error input
IRQ14 Primary IDE interface
IRQ15 Secondary IDE interface

6.7 System DMA

Table 6-9
DMA Channels

Hardware DMA System Function
DMA 0 Fast infrared or Audio controller
DMA 1 Audio controller
DMA 2 Diskette drive controller
DMA 3 EPP Parallel Port
DMA 4 Not assigned
DMA 5 Audio Controller
DMA 6 Not assigned
DMA 7 Not assigned
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6.8 System I/O Address

Table 6-10
System I/O (Port) Addresses

I/O Add ress (Hex) System Function (Shipping Configuration)
000 - 00F Master DMA Controller # 1
010 - 011 Force Software SMI
012 - 01F Unused
020 - 021 Peripheral Interrupt Controller # 1
022 - 024 Chipset Configuration Registers
025 - 03F Unused
040 - 043 Counter/Timer Registers
044 - 05F Unused
060 Keyboard Data
061 Port B
062 - 063 Unused
064 Keyboard Command/Status
065 - 06F Unused
070 CMOS Index Address
071 CMOS Data
072 - 073 Unused
074 Reserved
075 Unused
076 Reserved
077 - 077F Unused
080 - 08F DMA Page Registers
084 - 085 POST Code Output Port
090 - 091 Unused
092 Fast Reset Register
093 - 09F Unused
0A0 - 0A1 Interrupt Controller # 2
0A2 - 0BF Unused
0C0 - 0DF DMA Controller # 2
0E0 - 0E1 ESS Audio Configuration
0E2 - 0E5 Configuration Registers
0E6 - 0EF Unused
0F0 - 0F1 NCP Numerics Register
0F9 ESS Configuration Lock
0FA Unused
0FB ESS Configuration Unlock
0FC - 0FF Unused
100 - 101 Unused
103 - 16F Unused

Continued
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Table 6-10   Continued
I/O Add ress (Hex) System Function (Shipping Configuration)
170 - 177 Hard Drive Secondary Registers
178 - 1EF Unused
1F0 - 1F7 Hard Drive Primary  Registers
1F8 - 1FF Unused
200 - 21F Unused
220 - 22F ESS Audio Registers (1st Possible) (Default)
230 - 23F ESS Audio Registers (2nd Possible)
240 - 24F ESS Audio Registers (3rd Possible)
250 - 25F ESS Audio Registers (4th Possible)
260 - 277 Unused
278 - 27A LPT2  and High Speed Parallel Port  Registers
27B - 27F LPT2 High Speed Printer Port Registers
280 - 2F7 Unused
2F8 - 2FF Serial Control Register COM2
300 - 36F Unused
370 - 371 Reserved
372 Diskette Digital Output Register
373 Unused
374 Reserved
375 Diskette Main Status/Data Registers
376 Reserved
377 Diskette Input/Control Registers
378 - 37A LPT1 and High Speed Parallel Port Registers
37B - 37F Unused
380 - 387 Unused
388 - 38B ESS FM Synthesizer
38C - 3AF Unused
3B0 - 3BB Unused
3BC - 3BE LPT3 and High Speed Parallel Port  Registers
3BF LPT1 High Speed Parallel Port Registers
3C0 - 3CD Unused
3D0 - 3DF Unused
3F0 - 3F7 Diskette Drive Controller Primary Registers
3F8 - 3FF COM1 Serial Controller Registers
400 - 4CF Unused
480 - 48F Extended DMS Registers
4D0 - CF6 Unused
CF7 Configuration/NVM Data Register
CF8 - CFB PCI Configuration Index Register
CFC - CFF PCI Configuration Index Register
D00 - FFF Unused
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6.9 System Memory Map

Table 6-11
Memory Map

Size Memory Address System Function
640 K 00000000 - 0009FFFF Base Memory
128 K 000A0000 - 000BFFFF Video Memory
  48 K 000C0000 - 000CBFFF Video BIOS
160 K 000C8000 - 000E7FFF Unused
  64 K 000E8000 - 000FFFFF System BIOS
 15 M 00100000 - 00FFFFFF Extended Memory
 58 M 01000000 - 047FFFFF Super Extended Memory
 58 M 04800000 - 07FFFFFF Unused
   2 M 08000000 - 080FFFFF Video Memory (Direct Access)
   4 G 08200000 - FFFEFFFF Unused
 64 K FFFF0000  - FFFFFFFF System BIOS ("SHADOW")
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appendix
 A

CONNECTORS

This appendix contains the pin assignments for all external connectors.

Table A-1
External Keyboard

Connector Pin Signal

KEY

65

43

21
1
2
3
4
5
6

Data
Unused
Ground
+5 VDC
Clock
Unused

Table A-2
PS/2-Compatible Mouse

Connector Pin Signal

KEY

65

43

21
1
2
3
4
5
6

Data
Unused
Ground
+5 VDC
Clock
Unused

Table A-3
Ethernet RJ-45

Connector Pin Signal

6
5

4
3

2
1 7

8

1
2
3
4
5
6
7
8

(+) Transmit Data
(-) Transmit Data
(+) Receive Data
Unused
Unused
(-) Receive Data
Unused
Unused
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Table A-4
USB

Connector Pin Signal
1
2
3
4

Ground
- Data
+ Data
+5 VDC

Table A-5
External Monitor

1

6

11

5

10

15

Pin Signal Pin Signal
1 Red Analog   9 Blank
2 Green Analog 10 Ground
3 Blue Analog 11 Blank
4 Blank 12 Monitor ID (DD)
5 Ground 13 Horizontal Sync
6 Ground 14 Vertical Sync
7 Ground 15 Monitor ID (CC)
8 Ground

Table A-6
Diskette Drive Connector

Need connector part number or example

Pin Signal Pin Signal
1 18
2 19
3 20
4 21
5 22
6 23
7 24
8 25
9 26
10 27
11 28
12 29
13 30
14 31
15 32
16 33
17 34
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Table A-7
Parallel Connector

1

14 25

13

Pin Signal Pin Signal
Strobe 14 Auto Linefeed

  2 Data Bit 0 15 Error
  3 Data Bit 1 16 Initialize Printer
  4 Data Bit 2 17 Select In
  5 Data Bit 3 18 Ground
  6 Data Bit 4 19 Ground
  7 Data Bit 5 20 Ground
  8 Data Bit 6 21
  9 Data Bit 7 22
10 Acknowledge 23 Ground
11 Busy 24 Ground
12 Paper End 25
13 Select

Table A-8
Serial Connector

1

6 9

5

Pin Signal Pin Signal
1 Carrier Detect 6 Data Set Ready
2 Receive Data 7 Ready to Send
3 Transmit Data 8 Clear to Send
4 Data Terminal Ready 9 Ring Indicator
5 Ground
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Table A-9
Convenience Base Expansion Connector

Pin Signal Pin Signal
  1 GND 31 GREEN
  2 GND 32 CRTVSYNC
  3 NC 33 RED
  4 GND 34 DDCCLK
  5 GND 35 PWRLED
  6 NC 36 DDCDATA
  7 GND 37 DOCK_PWR_EN
  8 GND 38 GND
  9 AD[31] 39 SPKL
10 DEVSEL 40 LINE_L
11 IRDY 41 SPK_R
12 STOP 42 LINE_R
13 TRDY 43 GND
14 GND 44 DOCK_LG
15 GND 45 GND
16 AD[12] 46 GND
17 AD[13] 47 REQ1
18 GND 48 REQ0
19 GND 49 GNTO
20 CLK1 50 RST
21 AD[0] 51 GND
22 GND 52 AD[23]
23 DOCK_S 53 AD[22]
24 CLK0 54 C/BE2
25 ACVCC 55 AD[20]
26 ACVCC 56 NC
27 ACVCC 57 AD[19]
28 ACVCC 58 FRAME
29 ACVCC 59 AD[17]
30 CRTHSYNC 60 GND

Continued

Reviewers - please verify this connector - this table is from Masters.
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Table A-9 Continued
Pin Signal Pin Signal

61 GND   96 GND
62 AD[14]   97 CBE3
63 AD[15]   98 AD[21]
64 AD[1]   99 NC
65 AD[3] 100 NC
66 AD[2] 101 AD[18]
67 GND 102 C/BE1
68 MDATA 103 PAR
69 KBDATA 104 GND
70 MCLK 105 AD[16]
71 KBCLK 106 AD[6]
72 ACVCC 107 C/BE0
73 PMVCC5 108 AD[5]
74 PMVCC5 109 AD[7]
75 NC 110 AD[4]
76 BLUE 111 BATTLED
77 NC 112 SWC
78 PBUSY 113 TA
79 PDATA7 114 SWB
80 PBDATA3 115 SWD
81 PSLIN 116 SWA
82 GND 117 PMVCC5
83 GND 118 PMVCC5
84 SPK_IN 119 PMVCC5
85 +5v 120 PMVCC5
86 NC 121 PSELECT
87 ERDY 122 PDADA6
88 SYSVCC5A 123 PACK
89 STANDBy_SW 124 PDATA2
90 NC 125 PDATA0
91 NC 126 PFAULT
92 NC 127 GND
93 NC 128 GND
94 GNT1 129 DSRA
95 GND 130 DCDA

Continued
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Table A-9 Continued
Pin Signal Pin Signal

131 RTSA 154 AD[8]
132 RIA 155 PORT_REP
133 POWER_SW 156 MSI
134 INTB 157 MSO
135 NC 158 TC
136 INTA 159 TD
137 NC 160 TB
138 GND 161 PMVCC5
139 NC 162 PMVCC5
140 AD[27] 163 PPE
141 AD[30] 164 PMVCC5
142 AD[26] 165 PDATA4
143 AD[29] 166 PDATA5
144 AD[25] 167 PDATA1
145 AD[28] 168 PINIT
146 AD[24] 169 PSTB
147 BLOCK 170 PAFD
148 GND 171 GND
149 PERR 172 GND
150 SERR 173 CTSA
151 AD[11] 174 SINA
152 AD[9] 175 DTRA
153 AD[10] 176 SOUTA
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Table A-10
M35EU Convenience Base Connector

Need Convenience Base Connector Part Number and Illustration

Pin Signal Pin Signal

Table A-11
Speaker Connector

Pin Signal

1 Shield
2 Left channel audio
3 Right channel audio
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appendix
 B

POWER CORD SET
REQUIREMENTS

B.1 3-Conductor Power Cord Set

The wide range input feature of your computer permits it to operate from any line
voltage from 100 to 240 volts AC.

The power cord set received with the computer meets the requirements for use in the
country where you purchased the equipment.

Power cord sets for use in other countries must meet the requirements of the country
where you use the computer.

B.1.1 General Requirements

The requirements listed below are applicable to all countries:

1. The length of the power cord set must be at least 5.00 feet (1.5 m) and a maximum
of 6.56 feet (2.0 m).

2. All power cord sets must be approved by an acceptable accredited agency
responsible for evaluation in the country where the power cord set will be used.

3. The power cord set must have a minimum current capacity of 10A and a nominal
voltage rating of 125 or 250 volts AC, as required by each country’s power system.

4. The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC
320 Standard Sheet C5 connector, for mating with appliance inlet on the product.
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B.1.2 Country-Specific Requirements

3-Conductor Power Cord Set Requirements —  By Country
Country Accredited Agency A pplicable Note

Numbers
Australia EANSW 1
Austria OVE 1
Belgium CEBC 1
Canada CSA 2
Denmark DEMKO 1
Finland FIMKO 1
France UTE 1
Germany VDE 1
Italy IMQ 1
Japan JIS 3
Norway NEMKO 1
Sweden SEMKO 1
Switzerland SEV 1
United Kingdom BSI 1
United States UL 2

B.1.3 Notes:
1. The flexible cord must be <HAR> Type HO3VV-F, 3-conductor,  0.75 mm2

conductor size. Power cord set fittings (appliance coupler and wall plug) must bear
the certification mark of the agency responsible for evaluation in the country where
it will be used.

2. The flexible cord must be Type SPT-2 or equivalent, No. 18 AWG, 3-conductor.
The wall plug must be a two-pole grounding type with a NEMA 5-15P (15A, 125V)
or NEMA 6-15P (15A 250V) configuration.

The appliance coupler, flexible cord, and wall plug must bear a "T" mark and
registration number in accordance with the Japanese Dentori Law. The flexible cord
must be Type VCT or VCTF, 3-conductor, 0.75mm2 conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303
(15A, 125V) configuration.
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appendix
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CONVENIENCE BASES

C.1  Models and Features

The convenience bases provide a permanent desktop solution for the computer (when
docked to the M35EU) by eliminating the need to disconnect external devices such as a
printer, keyboard, or monitor when you undock the computer. All necessary
connections and disconnections are made automatically when the computer is docked
and undocked. The following convenience models are available:

Table C-1
Convenience Bases

Model Serial Configuration
Convenience Base Pass Through model BNH3 (Armada 1500 base)
Convenience Base with Ethernet BNH1 (Armada 1500 base)
Convenience Base II Pass Through
model

CBY1

Convenience Base II with Ethernet CBX1
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Figure C-1.  Compaq Convenience Base II
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C.2  Convenience Base Features

The Convenience Base pass through models and the convenience base with Ethernet
models include the following features:

Convenie
nce Base

pass
through

Convenie
nce Base

with
Ethernet

(BNC)

Convenie
nce Base

with
Ethernet
(RJ45)

Convenie
nce Base

II
pass

through

Convenie
nce Base

II
with

Ethernet

Connections
Speaker/headphone ■ ■ ■ ■ ■

Audio Line-In ■ ■ ■ ■ ■

Serial ■ ■ ■ ■ ■

Parallel ■ ■ ■ ■ ■

External Monitor ■ ■ ■ ■ ■

Keyboard ■ ■ ■ ■ ■

Pointing Device ■ ■ ■ ■ ■

MIDI/Joystick ■ ■ ■ ■ ■

USB ■ ■

Cable lock provision ■ ■ ■ ■ ■

Pass through AC
Power

■ ■ ■ ■ ■

RJ-45 connector ■ ■

BNC Connector ■

10-Base-T ■ ■ ■ 

100-Base-T  (optional) ■

Monitor Stand ■ ■ ■ ■ ■

Localized Power Cords ■ ■ ■ ■ ■

Kensington lock ■ ■ ■ ■ ■
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C.3  Convenience Base II Components

The convenience base components are illustrated and described in this section.

C.3.1 Front and Right Side Components
The front and right side convenience base components are shown and identified in this
section.

1 Docking latches

2 Docking alignment pins

3 Docking connector

4 Power switch

5 Security cable lock

6 Docking lever

7 Pass-through AC power outlet

8 Battery charge light

9 Suspend button

: Power/suspend light

; Retaining latches

Figure C-2 . Convenience Base II with RJ45 Front and Right Side
Components
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C.3.2 Rear Components
The rear components are shown in the following figure and identified in this section:

1 RJ-45 jack (Ethernet model only)

2 Serial connector

3 Parallel connector

4 External monitor connector

5 MIDI/Joystick connector

6 Pointing device connector

7 Keyboard connector

8 Speaker/headphone jack

9 USB connector

: Audio Line-in jack

; Fan

ω AC power connector

Figure C-3.  Convenience Base II with RJ45 Rear Components

Table C-2
Convenience Base Models

Item Description Spares Part Number
1 Convenience Base II (Ethernet

model)
316312-001
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* Convenience Base II (Pass through
model)

316291-001

 *Not illustrated

Table C-3
Convenience Base II Specifications

U.S. Metric
Dimensions
  Height   4.9 in   12.46 cm
  Height w/Monitor Stand   5.2 in   13.208 cm
  Length   14.7in   37.34 cm
  Width  14.2 in 36.07 cm
Weight
  Expansion Base 4.25 lbs 1.93 kg
  Expansion Base w/Monitor
Stand

5.8 lbs 2.63 kg

Power Supply (Input)
  Operating Voltage 100 to 240 VAC
  Operating Current 1.10 Amp Maximum
  Rated Voltage 100 to 240 VAC
  Rated Current 1.0 Amp Maximum
  Line Frequency 47 to 63 Hz.
Temperature
  Operating 50 to 95°F 10 to 35°C
   Storage -4 to 140°F 20 to 60°C
Relative Humidity
  Operating 10 to 90%
  Storage   5 to 95%
Altitude
  Operating 10,000 ft 3.15 km
  Nonoperating 30,000 ft 10.14 km
Shock
  Operating 10 G, 11 ms, half sine
  Nonoperating 140 G, 2 ms, half sine
Vibration
  Operating 0.25 G, 5 to 500 Hz, 0.5 octave/min sweep rate
  Nonoperating 1.0 G, 5 to 500 Hz, 0.5 octave/min sweep rate

Table C-4
Convenience Base II Cables and Power Cords

Description Spares Part Number
* AC Power cord (US/Canada) 255135-001
* AC Power cord (Australia/New

Zealand)
255135-011

* AC Power cord (UK) 255135-011
* AC Power cord (Europe) 255135-021
* AC Power cord (Italy) 255135-061
* AC Power cord (Denmark) 255135-081
* AC Power cord (Singapore) 255135-111
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* AC Power cord (Japan) 255135-291
* AC Power cord (Korea) 255135-AD1

* Not illustrated

Table C-5
Convenience Base II Options

Description Spares Part Number
Monitor Stand 316286-001

Table C-6
Convenience Base II Shipping Boxes

Description Spares Part Number
Shipping Carton (5 ea) 210432-001
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Index

A
AC power cord

3-conductor, 2-1
spare part number, 3-5

AC Power Module
spare part number, 3-5

audio
solving problems, 2-17
test error codes, 2-14

audio/LED board
spare part number, 3-6

automobile/aircraft adapter
spare part number, 3-7

auxiliary battery
removal, 5-13

B
base enclosure assembly

spare part number, 3-3
battery

pack
solving problems, 2-19

battery charger
described, 1-4
spare part number, 3-7
specifications, 6-7

battery pack
removal, 5-7
spare part number, 3-7

beep codes, 2-6
boot, 2-15

C
cables

handling, 4-2
spare part number, 3-5

CD-ROM drive
caring for, 4-2
removing and inserting, 4-2
solving problems, 2-20
specifications, 6-6
test error codes, 2-14

clock battery removal, 5-12
Compaq Diagnostics, 2-15

Compaq Utilities, 2-7
components

bottom, 1-10, 1-11
rear, 1-9
right side, 1-8

computer
features
optional, 1-3
standard, 1-2

models, 1-1
specifications, 6-2

computer checkup (TEST)
error codes, 2-10

computer setup, 2-8, 2-9
computer undocking, 5-3
connector

care when handling, 4-2
connector pin assignments

expansion, 1-4
convenience base

described, 1-3
models, 3-1

convenience base components
front and right side, 3-3
rear, 3-4

Convenience Base II
spare part number, 3-7
specifications, 3-5

country kit
spare part number, 3-9

D
damage, preventing

from electrostatic discharge,
4-3

to cables and connectors, 4-2
to plastic parts, 4-1
to removable drives, 4-2

DC-DC converter
removal, 5-24
spare part number, 3-6

design overview
computer, 1-13

disassembly preparation
computer, 5-3

disassembly sequence, 5-2
disconnecting power, 5-3

diskette drive
caring for, 4-2
error codes, 2-12
removing and inserting, 4-2
solving problems, 2-21
spare part number, 3-4
specifications, 6-5

display
solving problems, 2-30, 2-31
spare part number, 3-3
specifications, 6-3

display assembly
removal, 5-20

display hinge cover
removal, 5-17

DMA channels, 6-8
DMA, system, 6-8
documentation spare part

numbers, 3-10
drive

CD-ROM
caring for, 4-2
removing and inserting, 4-2

diskette
caring for, 4-2
removing and inserting, 4-2

hard
caring for, 4-2
removing and inserting, 4-2

E
electrostatic discharge

preventing damage, 4-3
shielding materials, 4-6
typical voltage levels, 4-6

error codes
audio test, 2-14
CD-ROM test, 2-14
computer checkup (TEST),

2-10
diskette drive test, 2-12
keyboard test, 2-11
memory test, 2-11
parallel printer test, 2-11
pointing device interface

test, 2-14
processor test, 2-10
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serial test, 2-12
video test, 2-13

external computer
components

bottom, 1-10, 1-11
front, 1-6
left side, 1-5
rear, 1-9
right side, 1-8
top, 1-7

external connectors
keyboard, 1-1
monitor, 1-2
mouse, 1-1
parallel, 1-3, 1-7
RJ-45, 1-1
serial, 1-3
speaker, 1-7
USB, 1-2

external keyboards, 1-4
external monitor, 1-4

solving problems, 2-30, 2-31
external pointing devices, 1-4

F
fan

spare part number, 3-9
fan removal, 5-26
fatal error

beep codes, 2-6
messages, 2-5

features, 1-2

G
grounding

equipment and methods, 4-5
packaging and transporting,

4-3
workstations, 4-4

H
hard drive

caring for, 4-2
removal, 5-11
removing and inserting, 4-2
solving problems, 2-22
specifications, 6-4

hard drive adapter
spare part number, 3-7

hardware installation
solving problems, 2-23

hardware interrupts, 6-8

I
I/O addresses, 6-9
infrared

connection
solving problems, 2-24

INSPECT, 2-15
installation

memory board, 5-10
interrupt requests (IRQ)

system, 6-8
IR module

spare part number, 3-6
IRQ assignments, 6-8

K
keyboard

external, 1-4
removal, 5-15
spare part number, 3-3
test error codes, 2-11

L
lithium clock battery

removal, 5-12
logo kit

spare part number, 3-9

M
magnetic fields, avoiding, 4-2
mass storage devices

spare part number, 3-4
battery pack, 3-4
CD-ROM drive, 3-4
diskette drive, 3-4
hard drive, 3-4

memory
test error codes, 2-11

memory board
installing, 5-10
removal, 5-8
spare part number, 3-6

memory map
system, 6-11

memory options, 1-3

messages
fatal error, 2-5
warning, 2-4

models, 1-1, 3-1
modem

solving problems, 2-25
spare part number, 3-6

monitor
optional, 1-4
solving problems, 2-30, 2-31

monitor stand
spare part number, 3-7

O
optional boards

spare part number, 3-6
options, 1-3

P
panel lights, 1-12
parallel port

test error codes, 2-11
pass-through connections,

listing, 3-2
passwords

clearing, 2-3
PC Card

removal, 5-6
solving problems, 2-28

PCMCIA
removal, 5-6

plastic parts, handling, 4-1
plastics kit

spare part number, 3-9
pointing device

interface test error codes,
2-14

pointing devices
external, 1-4

power
solving problems, 2-29

power cord
general requirements, 2-1

country-specific
requirements, 2-2

requirements, 2-1
spare part number, 3-5

power cord set
notes for 3-conductor, 2-2
spare part number, 3-5
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power-on password
clearing, 2-3

processor
test error codes, 2-10

R
removal

auxiliary battery, 5-13
battery pack, 5-7
DC-DC converter, 5-24
display assembly, 5-20
display hinge covers, 5-17
fan, 5-26
hard drive, 5-11
keyboard, 5-15
memory board, 5-8
PCMCIA (PC Card), 5-6
RTC battery, 5-12
switch cover, 5-18
system board, 5-25
top cover assembly, 5-22

removal and replacement
preliminaries, 4-1

RTC battery
removal, 5-12
spare part number, 3-5

S
screen

solving problems, 2-30, 2-31
screw kit

spare part number, 3-9
serial

port
test error codes, 2-12

serial number, v
computer, 5-1

service considerations, 4-1
service preliminaries, 4-1
setup password

clearing, 2-3
shipping drives, 4-2
software

backup, 1-3

fulfillment, 1-3
spare part number

AC power cord, 3-5
automobile/aircraft adapter,

3-7
battery, 3-7
battery charger, 3-7
cables, 3-5
Convenience Base II, 3-7
country kit, 3-9
diskette drive, 3-4
documentation, 3-10
external battery charger, 3-7
hard drive, 3-4
hard drive adapter, 3-7
keyboard, 3-3
logo kit, 3-9
power cords, 3-5

specifications
battery charger, 6-7
CD-ROM drive, 6-6
computer, 6-2
Convenience Base II, 3-5
diskette drive, 6-5
display, 6-3
hard drive, 6-4

standard boards
spare part number, 3-6

standby battery
removal, 5-13

status panel lights, 1-12
switch cover

removal, 5-18
system

DMA, 6-8
I/O address, 6-9
interrupts, 6-8
memory map, 6-11
memory options, 1-3

system board
removal, 5-25
spare part number, 3-6

system information, 2-15
system unit, 3-2

T
technician notes, v
tools required for service, 4-1
top cover assembly

removal, 5-22
spare part number, 3-3

troubleshooting
audio, 2-17
battery, 2-19
CD-ROM drive, 2-20
diskette drive, 2-21
external monitor, 2-30, 2-31
hard drive, 2-22
hardware installation, 2-23
infrared connection, 2-24
modem, 2-25
PC Card, 2-28
power, 2-29
preliminary steps, 2-2
screen, 2-30, 2-31
without diagnostics, 2-17

U
undocking

convenience base, 5-3
mobile expansion unit, 5-4

V
video test error codes, 2-13

W
warning messages, 2-4
Windows NT

infrared connection, 2-24
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